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Über die X4 Suite

Digitalisierung braucht eine ganzheitliche Betrachtung, die sich in der einzusetzenden Lösung 
widerspiegeln muss. Als zentrale Plattform unterstützt Sie die X4 Suite dabei, diese 
Herausforderungen zu lösen. Im Fokus stehen dabei die Modellierung, Implementierung und 
Überwachung Ihrer Geschäftsprozesse. Daher enthält die X4 Suite alle benötigten Werkzeuge und ist 
mit einer Vielzahl an Schnittstellen und Formaten kompatibel. Mit der X4 Suite vermeiden Sie isolierte 
Informationssilos, produktivitätshemmende Medienbrüche und beschleunigen die Digitalisierung. 

Geschäftsprozesse ohne Programmieraufwand zu realisieren, ermöglicht einem großen 
Anwenderkreis den Einstieg in das Management von Geschäftsprozessen. Das lohnt sich, denn 
Mitarbeiter der Fachabteilung wissen in der Regel am besten, worauf es bei den jeweiligen 
Geschäftsabläufen im Kern ankommt. Setzen Sie daher auf die X4 Suite als Plattform, deren 
Werkzeuge die Komplexität soweit reduzieren, dass sich auch ohne Programmierkenntnisse 
Geschäftsprozesse analysieren, optimieren, modellieren als auch kontrollieren und dokumentieren 
lassen. Alle Werkzeuge unterstützen eine integrierte, grafische Prozessmodellierung und 
-implementierung und erzeugen Prozesse, die von der X4 Suite performant ausgeführt werden.

X4 Designer: Prozesse und Regeln grafisch modellieren
X4 Server: Simulation und Ausführung der Prozesse und Regeln
X4 Adapter: Drittsysteme in Prozesse integrieren
X4 Activities: Web Apps für Mitarbeiter und Kunden bereitstellen
X4 Control Center: Alle Prozesse und Apps überwachen und verwalten

An wen richtet sich dieses Dokument?

Dieses Dokument richtet sich an alle Anwender, die mit der X4 Suite ihre Geschäftsprozesse 
erfassen, modellieren und optimieren möchten. Die X4 Suite bietet hierfür mit dem X4 Designer den 
international etablierten Standard BPMN 2.0 (Business Process Model and Notation).  Zudem macht 
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Sie diese Dokumentation mit den grundlegenden Prinzipien der Modellierung von Geschäftsprozessen 
mit der X4 BPM Suite vertraut und erläutert die Bedienung des X4 Designers und seiner zahlreichen 
Werkzeuge.
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1 BPMN Editor
Mit dem BPMN Editor können Sie fachliche Prozesse gemäß dem Notationsstandard BPMN 
2.0 modellieren. Er entspricht in Aufbau und Bedienweise zu weiten Teilen dem Process Editor im X4 
Designer, unterscheidet sich jedoch hinsichtlich der Prozessbausteine bzw. Symbole im Prozess-
Diagramm. Mit dem BPMN Editor werden die modellierten Geschäftsprozesse direkt mit den 
technischen IT-Prozessen verknüpft. Ohne die Entwicklungsumgebung zu wechseln, können Sie also 
Ihre fachlichen und technischen IT-Prozesse modellieren und über den X4 Server testen und 
ausführen.
Da in BPMN-Prozesse auch nicht-automatisierbare Aktionen – etwa Arbeitsabläufe von Menschen –
 eingebunden werden können, lassen sich BPMN-Prozesse nicht notwendigerweise auf dem X4 Server 
ausführen.

1.1 Die Oberfläche des BPMN Editors
Der BPMN Editor ist in mehrere Bereiche aufgeteilt, die im Folgenden vorgestellt werden.

1 Editoren und 
Zeichnungsfläche

Prozesse und Dateien werden hier zum Anzeigen und Bearbeiten 
in Registerkarten geöffnet.

2 Menüleiste In der Menüleiste lassen sich verschiedene Funktionen und 
Editoren des X4 Designers aufrufen.

3 Symbolleiste Über die Symbolleiste können verschiedene Funktionen und 
Anzeigeoptionen aufgerufen werden. Einige Symbole sind nur 
aktiv, wenn die entsprechende Funktion für das ausgewählte 
oder geöffnete Element verfügbar ist, siehe auch Symbolleiste 
des BPMN Editors.

Im Free-flow-Modus besteht zusätzlich die Möglichkeit, den BPMN Editor als reines BPMN-
Zeichen-Werkzeug mit einer erweiterte BPMN-Palette zu verwenden, bei der die Run/Debug-
Funktion deaktiviert ist.


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4 Palette Die Palette enthält Prozess-Bausteine, die per Drag&Drop in die 
Zeichnungsfläche gezogen werden können. Abhängig vom 
verwendeten Editor stehen unterschiedliche Bausteine zur 
Verfügung, siehe auch BPMN-Prozessbausteine und ihre 
Verwendung.

Sichten

5 Outline Zeigt das vollständige Prozess-Diagramm als Abbildung. Durch 
Anklicken der einzelnen Bereiche der Abbildung kann leicht 
durch den Prozess navigiert werden, selbst wenn dieser größer 
als die Größe des Designer-Fensters ist.

 Die Outline-Sicht lässt sich über das Menü View > Outline
aufrufen.

6 Error Log Im Error Log lassen sich im X4 Designer aufgetretene Fehler 
einsehen.

Über die Symbolleiste lassen sich zusätzlich folgende Aktionen 
vornehmen:

 Export Log: Error Log exportieren und als .log-Datei 
speichern

 Import Log: Error Log (.log) importieren
 Clear Log Viewer: Error Log bereinigen 
 Delete Log: Error Log unwiderruflich löschen
 Open Log: Log-Datei (.log) im X4 Designer öffnen
 Restore Log: Error Log wiederherstellen
View Menu: Zusatzoptionen öffnen

 Das Error Log lässt sich über das Menü View > Error Log
aufrufen.
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7 Run/Debug Console Wird ein Prozess auf Fehler überprüft bzw. simuliert, werden in 
der Run/Debug Console-Sicht zu jedem ausgeführten Prozess-
Schritt Debug-Informationen angezeigt. Fehlermeldungen 
werden rot hervorgehoben, erfolgreiche Statusmeldungen sind 
grün.

Wenn ein Prozess-Schritt ein Zwischenergebnis ausgibt, wird 
dieses während des Debuggens in einer temporären Datei 
gespeichert, die Sie über den entsprechenden Verweis ansehen 
können (z. B. file://1376054979039/). 

 Die Run/Debug-Console-Sicht lässt sich über das Menü View 
> Run/Debug Console aufrufen.

8 Call Hierarchy In der Call-Hierarchy-Sicht lässt sich zu jedem Prozess und 
Prozessbaustein im Repository anzeigen, von welchen 
Repository-Elementen diese verwendet werden.

Durch Rechtsklick auf das gewünschte Element im Repository 
Navigator wird ein Kontextmenü aufzurufen. Mit View Call 
Hierarchy wird anschließend eine Auflistung aller Repository-
Elemente angezeigt, die mindestens eine Referenz auf das 
markierte Element enthalten.

9 X4 Server Log In der Server-Log-Sicht lassen sich der Server-Status und 
insbesondere Fehler im X4-Server-Log aus dem X4 Designer 
heraus verfolgen.

 Die Server-Log-Sicht lässt sich über das Menü View > X4 
Server Log aufrufen.
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10 Output In der Output-Sicht lassen sich die Ergebnisse jedes einzelnen 
Debug-Schrittes einsehen.

Über die Symbolleiste lassen sich zusätzlich folgende Aktionen 
vornehmen:

 Save content of output view: Daten aus der Output-Sicht 
speichern

 Format the content of the output view: Daten aus der 
Output-Sicht formatieren

 Die Output-Sicht lässt sich während des Debuggens über das 
Menü Debug > Output oder über das Output-Icon  in der 
Symbolleiste aufrufen.

Enthält das Ergebnis Inhalte, die größer als 1 MB sind, 
wird eine Warnung angezeigt und das Ergebnis lässt sich 
über eine Schaltfläche herunterladen.
Große Datenmengen können sich negativ auf die 
Leistungsfähigkeit des X4 Designers auswirken. 


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11 Quick Watch In der Quick-Watch-Sicht lassen sich Platzhalter, dynamischen 
Parameter und Kontextvariablen mit deren Werten während des 
Debuggens betrachten.

Ausgewählte Variablen werden nach jedem Debug-Schritt 
aktualisiert.

 Die Quick-Watch-Sicht lässt sich während des Debuggens 
über das Menü Debug > Quick Watch oder über das Quick-Watch-
Icon  in der Symbolleiste aufrufen.

Enthält das Ergebnis des Debug-Schrittes Inhalte, die 
größer 1 MB sind, wird eine Warnung angezeigt und das 
Ergebnis lässt sich über eine Schaltfläche 
herunterladen.
Große Datenmengen können sich negativ auf die 
Leistungsfähigkeit des X4 Designers auswirken. 


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12 Properties Hier lassen sich die Eigenschaften von markierten 
Prozessbausteinen und von geöffneten Prozessen anzeigen und 
bearbeiten:

In der linken Spalte befinden sich die Eigenschaften, in der 
rechten Spalte die zugehörigen Werte.
Für jeden Prozesse kann ein Titel sowie eine Beschreibung 
hinterlegt werden. Diese werden in der erzeugten 
Dokumentation angezeigt.
Um die Eigenschaften eines geöffneten Prozesses zu 
bearbeiten, auf einen leeren Bereich auf der 
Zeichnungsfläche klicken.

Standardmäßig werden die gebräuchlichsten Eigenschaften 
angezeigt, über die Symbolleiste der Properties-Sicht lassen 
sich jedoch zusätzliche Einstellungen vornehmen:

 Pin to Selection: Die angezeigten Eigenschaften in der 
Properties-Sicht anheften

 Show Categories: Eigenschaften nach Kategorien 
geordnet anzeigen

 Show Advanced Properties: Erweiterte Eigenschaften 
anzeigen

 Restore Default Value: Auf Standardwerte zurücksetzen

View Menu: Zusatzoptionen öffnen
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13 Repository Navigator Die Repository Navigator-Sicht enthält eine Baumstruktur des 
verbundenen Repositorys mit verschiedenen Elementen wie 
Projekten, Ordnern und Dateien. Das Kontextmenü lässt sich per 
Rechtsklick auf ein Element im Repository Navigator aufrufen. 
Die verfügbaren Optionen ändern sich je nachdem, an welcher 
Stelle in der Baumstruktur das Kontextmenü aufgerufen wird.

Über das Filter-Textfeld über dem Projektbaum kann nach 
Dateien innerhalb des verbundenen Repositorys gesucht 
werden. Platzhalter wie * oder ? sind nicht möglich.

Über verschiedene Schaltflächen lassen sich folgende Aktionen 
vornehmen:

 Jump from active Editor to Repository Navigator: 
Geöffnete Datei im Editor im Repository Navigator 
markieren.

 Show or hide all files: Inhalt des Dateisystems einblenden 
und ausblenden. Aus dem Projekt exkludierte Dateien werden 
dabei ausgegraut dargestellt.

14 Find in Files Die Find in Files-Sicht werden die Ergebnisse der Suche im 
Repository angezeigt. Dateien können über Edit > Find in Files
durchsucht werden.

Entwickler-Hilfswerkzeuge Entwickler-Hilfswerkzeuge als Sicht öffnen, siehe auch Entwickl
er-Hilfswerkzeuge

Base64: Zeichenketten Base64-kodieren oder dekodieren
Digest: Hash-Wert für Zeichenketten erzeugen
Regex: Regulären Ausdruck (Regex) auf eine Zeichenkette 
anwenden, um den Ausdruck zu testen oder um die 
Zeichenkette gemäß einem Muster direkt zu ersetzen
URLCodec: Zeichenketten URL-kodieren oder dekodieren

1.2 Symbolleiste des BPMN Editors
Über die Symbolleiste können verschiedene Funktionen und Anzeigeoptionen aufgerufen werden. 
Einige Symbole sind nur aktiv, wenn die entsprechende Funktion für das ausgewählte oder geöffnete 
Element verfügbar ist.

New Neues Element hinzufügen, z. B. einen BPM-Prozess

 Die Einfügeoption variiert je nachdem, wo man sich in der 
Baumstruktur im Repository Navigator befindet.

Save Änderungen im aktuell geöffneten Fenster speichern

Save all Alle Änderungen speichern

Refresh Server-seitige Aktualisierung durchführen
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Undo Letzten Bearbeitungsschritt rückgängig machen

Redo Rückgängig gemachten Schritt wiederherstellen

Cut Auswahl ausschneiden

Copy Auswahl kopieren

Paste Auswahl einfügen

Start Debugging Optionen zur Prozessausführung aufrufen

Start Debugging: Prozess debuggen (Fehler anzeigen 
und beseitigen)
Start Without Debugging: Prozess direkt ausführen
Debug/Run Options: Run/Debug-Einstellungen im X4 
Designer öffnen

Suspend Debugging-Vorgang anhalten

Resume Debugging fortsetzen

Stop Debugging Debugging beenden

Step Into Prozess-Schritt ausführen (Schritte des Subprozesses anzeigen)

Step Over Prozess-Schritt ausführen (ohne Schritte des Subprozesses 
anzuzeigen)

Step Return Aus Subprozess herausspringen

Toggle Breakpoint Breakpoint (Debug-Haltepunkt) zu markiertem Baustein setzen 
oder entfernen

Clear all Breakpoints Alle Breakpoints in diesem Prozess löschen

Quick Watch Quick Watch-Sicht öffnen, um Platzhalter, dynamischen 
Parameter und Kontextvariablen mit deren Werten während des 
Debuggens zu betrachten.

Output Output-Sicht öffnen, um das Ergebnis jedes Prozess-Schrittes 
während des Debuggens zu betrachten.

Zoom Out Ansicht verkleinern

Zoom Zoom-Stufe wählen
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Zoom In Ansicht vergrößern

Snap to grid Raster einblenden und Bausteine am Raster ausrichten

1.3 Kontextmenü im X4 Designer
Kontextmenü für Prozessbausteine 

Wenn Sie im Editor-Bereich des X4 Designers auf einen Prozessbaustein rechtsklicken, stehen Ihnen 
je nach Bausteinart und Prozesstyp verschiedene Funktionen zur Verfügung:
Add Component Neue Prozesskomponente hinzufügen
Layout Ausgewählte Prozesskomponenten ausrichten

Align Horizontal: Komponenten anhand des Mittelwertes 
horizontal ausrichten
Align Vertical: Komponenten anhand des Mittelwertes 
vertikal ausrichten
Distribute Horizontal: Komponenten gleichmäßig 
horizontal verteilen
Distribute Vertical: Komponenten gleichmäßig vertikal 
verteilen

Select All Alle Prozesskomponenten auswählen
Copy Process Diagram to 
Clipboard

Prozessdiagramm zwischenspeichern

Edit Label... Namen der Prozesskomponente bearbeiten
Undo ... Rückgängig machen

Redo ... Letzten Schritt wiederherstellen

Copy Markierten Prozessbaustein kopieren

Cut Markierten Prozessbaustein ausschneiden

Set ... document Markierten Baustein durch ein anderes Element im Repository 
austauschen

Edit ... Markierten Baustein/Datei bearbeiten (nur Modul-Bausteine und 
Dokumente)

Toggle Breakpoint Debug-Haltepunkt setzen

Delete Prozessbaustein aus dem Prozessdiagramm entfernen

Validate Subprozess auf Gültigkeit prüfen (Nur bei Subprozessen)
Preview Prozessbaustein in separatem Editor öffnen (Nur bei Modul-

Bausteinen und Dokumenten)
Show input schema Input-Schema des Subprozesses anzeigen, falls vorhanden
Show output schema Output-Schema des Subprozesses anzeigen, falls vorhanden
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Select in Repository 
Navigator

Prozessbaustein im Repository Navigator zeigen

View Call Hierarchy Verwendungsnachweis für den markierten Prozessbaustein anzeigen

View Documentation (Nur bei Subprozessen): Prozess-Dokumentation temporär im Editor-
Bereich anzeigen

Refresh Prozessbaustein neu aus dem Repository laden (Nur bei Modul-
Bausteinen und Dokumenten)

Bring to Front Symbol in den Vordergrund des Diagramms setzen
Bring Forward Symbol im Diagramm eine Ebene nach vorne setzen

Send Backward Symbol im Diagramm eine Ebene nach hinten bringen

Send to Back Symbol in den Hintergrund des Diagramms setzen

Properties Eigenschaften des Prozessbausteins in der Properties-Sicht anzeigen

Schema Declaration ... Schema-Deklaration für den Prozess hinterlegen

Kontextmenü im Repository Navigator

Das Kontextmenü können Sie per Rechtsklick auf ein Element im Repository Navigator aufrufen.

New Neue Elemente (Prozesse, Ordner, Adapter etc.) im Repository 
anlegen

Open / Open with Markiertes Element (Prozess, Ordner, Adapter etc.) mit dem 
Standard-Editor oder einem bestimmten Editor öffnen

Save As Template Markiertes Element als Vorlage speichern
Copy full path to Clipboard /
Copy XStore URL to 
Clipboard

Pfad zur markierten Datei in die Zwischenablage kopieren (als 
Ordnerpfad oder als xstore://-URL)

Cut, Copy und Paste Markierte(s) Element(e) ausschneiden, kopieren oder einfügen
Delete Markiertes Element aus dem Repository löschen (kann nicht 

rückgängig gemacht werden)
Refactor/Rename Element (und falls gewünscht dessen Referenzen) umbenennen
Exclude from Project Ressource aus dem Projekt ausschließen

Include to Project Ausgeschlossene Ressource wieder in das Projekt aufnehmen
Repair References Pfade von Repository-Ressourcen in Prozessdiagrammen reparieren
Validate Prozess auf Gültigkeit prüfen

•

•

Die Datei wird im Dateisystem beibehalten, ist jedoch 
nicht mehr Bestand des Projektes und wird ausgegraut 
dargestellt.
Die üblichen Operationen wie öffnen, bearbeiten, 
kopieren, löschen usw. von ausgeschlossenen Dateien ist 
unterbunden.


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Show Process in X4 Control 
Center

Prozess im X4 Control Center anzeigen

Show Process 
Documentation

Prozessdokumentation erzeugen und im Browser anzeigen

View Call Hierarchy Anzeigen, in welchen Prozessen dieses Element verwendet wird
Start Without Debugging Prozess direkt ausführen
Import Ressource ins Repository importieren
Export Projekt oder Ressource exportieren
Clean-Up X4 Project Nicht verwendete Dateien auswählen und aus dem Repository 

löschen

1.4 BPMN-Prozessbausteine und ihre Verwendung
Am rechten Rand der Zeichnungsfläche befindet sich eine ausklappbare Werkzeugleiste, die Palette. 
Sie enthält Prozessbaustein-Symbole, die Sie per Drag&Drop in die Zeichnungsfläche ziehen können. 
Folgende Prozessbausteine stehen für die Modellierung von Geschäftsprozessen (.bpm) zur 
Verfügung:

1.4.1 Events
Beim Anlegen eines neuen BPM-Prozesses werden standardmäßig bereits ein Start- und ein End-
Event in das Prozess-Diagramm eingefügt. Darüber hinaus lassen sich weitere Event-Bausteine aus 
der Palette in das Prozess-Diagramm ziehen und bei der Prozess-Modellierung verwenden. Die 
verfügbaren Bausteine werden im Folgenden näher erläutert.

1.4.1.1 Start

 Start: Definiert gemäß BPMN 2.0 das Start-Ereignis des Geschäftsprozesses und ermöglicht 
die Unterscheidung hinsichtlich verschiedener Ereignistypen.

Eigenschaften

Lab
el

Beschriftung des Symbols im Prozess-Diagramm
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Eve
nt

Ereignistyp

Mögliche Werte:

None Start: Allgemeines Start-Ereignis (Standard)

Error Start: Start-Ereignis bei einem Fehler

Message Start: Nachrichtenbasiertes Start-Ereignis

Multiple Start: Mehrfaches Start-Ereignis

Conditional Start: Start-Ereignis basierend auf einer Geschäftsregel

Signal Start: Start-Ereignis, das einem Signal folgt

Timer Start: Zeitgesteuertes Start-Ereignis

Escalation Start: Start-Ereignis basierend auf eine Eskalation
Compensation Start: Start-Ereignis, das auf eine Kompensierung basiert
Parallel Multiple Start: Mehrfaches paralleles Start-Ereignis

1.4.1.2 Intermediate

 Intermediate: Definiert gemäß BPMN 2.0 ein Zwischenereignis innerhalb eines 
Geschäftsprozesses und ermöglicht es zudem einen Vorgangs-Statuswert über die Eigenschaft Case 
State zu setzen, siehe Vorgangs-Statuswerte verwalten.

Eigenschaften

Case Management
Case 
State

Vorgangs-Status, der mit diesem Element gesetzt werden soll

Mögliche Werte: Bereits definierte Vorgangs-Statuswerte; Sie können die verfügbaren 
Vorgangs-Statuswerte mit Klick auf , siehe Vorgangs-Statuswerte verwalten.

Technical
Docum
ent

Pfad zum entsprechenden Prozess im X4 Repository

Label Beschriftung des Symbols im Prozess-Diagramm

 verwalten
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1.
2.

Event Ereignistyp

Mögliche Werte:

None Intermediate: Allgemeines Zwischen-Ereignis (Standard)

Message Intermediate (Catch): Eingehendes Nachrichten-Zwischen-Ereignis
Message Intermediate (Throw): Ausgehendes Nachrichten-Zwischen-Ereignis

Cancel Intermediate: Abbruch-Zwischen-Ereignis

Compensation Intermediate (Catch): Eingehendes Kompensations-Zwischen-
Ereignis

Compensation Intermediate (Throw): Ausgehendes Kompensations-Zwischen-
Ereignis

Error Intermediate: Fehler-Zwischen-Ereignis
Escalation Intermediate (Catch): Eingehendes Eskalations-Zwischen-Ereignis

Escalation Intermediate (Throw): Ausgehendes Eskalations-Zwischen-Ereignis

Multiple Intermediate (Catch): Eingehendes Mehrfach-Zwischen-Ereignis

Multiple Intermediate (Throw): Ausgehendes Mehrfach-Zwischen-Ereignis

Conditional Intermediate: Geschäftsregel-Zwischen-Ereignis

Signal Intermediate (Catch): Eingehendes Signal-Zwischen-Ereignis

Signal Intermediate (Throw): Ausgehendes Signal-Zwischen-Ereignis

Parallel Multiple Intermediate: Mehrfaches Parallel-Zwischen-Ereignis
Link Intermediate (Catch): Eingehendes Link-Zwischen-Ereignis
Link Intermediate (Throw): Ausgehendes Link-Zwischen-Ereignis

Vorgangs-Status mit Intermediate Events setzen

Mit Intermediate Events können Sie den Status eines Vorgangs setzen, der zur Laufzeit des aktuellen 
Geschäftsprozesses bearbeitet werden soll. Hierzu stehen in Eigenschaft Case Management > Case 
State alle prozessweit definierten Vorgangs-Statuswerte zur Auswahl zur Verfügung. Dazu gehen Sie 
wie folgt vor:

Intermediate Event aus der Palette in den Zeichnungsbereich ziehen.
Für das markierte Event-Element in der Properties-Sicht in Eigenschaft Case Management > 
Case State einen bereits hinterlegten Vorgangs-Status auswählen, z. B. IN PROGRESS.

Der Vorgangs-Status wird nun bei der Ausführung dieses Geschäftsprozesses auf den neuen 
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein 
Vorgangs-Status für den Geschäftsprozess definiert. Die verfügbaren Vorgangs-
Statuswerte können Sie neben dem Wert von Eigenschaft Case State mit Klick auf 

 verwalten, siehe Vorgangs-Statuswerte verwalten.


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1.
2.

1.4.1.3 Timer-based Intermediate

 Timer-based Intermediate : Definiert gemäß BPMN 2.0 ein zeitgesteuertes 
Zwischenereignis innerhalb eines Geschäftsprozesses und ermöglicht es zudem einen Vorgangs-
Statuswert über die Eigenschaft Case State zu setzen, siehe Vorgangs-Statuswerte 
verwalten .Eigenschaften

Case Management
Case 
State

Vorgangs-Status, der mit diesem Element gesetzt werden soll

Mögliche Werte: Bereits definierte Vorgangs-Statuswerte; Sie können die verfügbaren 
Vorgangs-Statuswerte mit Klick auf , siehe Vorgangs-Statuswerte verwalten.

Technical
Durat
ion

Wartezeit bis zum Eintreten des Ereignisses

Mögliche Werte:

Beliebige Dauer mit Angabe Tagen, Stunden, Minuten, Sekunden und Millisekunden

                      9999d 23h 59m 59s 999ms
                    : Maximale Wartezeit

                      0d 0h 0m 0s 0ms
                    : Keine Wartezeit (Standard)

 Alternativ zur Angabe einer Wartezeit lässt sich über Until ein Endzeitpunkt festlegen.

Sie können die Wartezeit-Konfiguration mit Klick auf 

Label Beschriftung des Symbols im Prozessdiagramm

1.4.1.3.1 Zeitgesteuertes Ereignis konfigurieren

Timer-based Intermediate Event aus der Palette ins Prozessdiagramm ziehen.
Für das markierte Event-Element in der Properties-Sicht in Eigenschaft Case State einen 
bereits hinterlegten Vorgangs-Status auswählen, z. B. 
            IN PROGRESS
          .

Alternativ kann der Vorgangs-Status auch dynamisch über technische Prozesse gesetzt 
werden. Hierzu steht der Case Management Adapter zur Verfügung.



 verwalten

 oder per Doppelklick auf den Event im Prozessdiagramm öffnen.
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3.

4.

5.

1.

Der Vorgangs-Status wird nun bei der Ausführung dieses Geschäftsprozesses auf den neuen 
Wert gesetzt. Dies wird durch eine entsprechende Beschriftung des Events gekennzeichnet.

Wartezeit-Konfiguration mit Klick auf neben der Eigenschaft Duration oder per Doppelklick 
auf den Event im Prozessdiagramm öffnen.

Gewünschte Wartezeit durch Angabe von Tagen, Stunden, Minuten, Sekunden 
und Millisekunden konfigurieren.

Die Konfiguration mit OK speichern.

1.4.1.3.2 Zeitgesteuerte Ereignisse dynamisch konfigurieren

Zeitgesteuerte Ereignisse lassen sich auch dynamisch über technische Prozesse und einem 
entsprechenden Mapping konfigurieren. Der entsprechende Prozess wird über das Timer-based 
Intermediate Event angelegt und verwaltet. Er wird direkt unter dem entsprechenden BPM-Prozess 
angelegt und kann auch nicht verschoben werden.  

Wartezeit-Konfiguration mit Klick auf  neben der Eigenschaft Duration oder per Doppelklick 
auf den Event im Prozessdiagramm öffnen.

Falls noch kein Wert in Eigenschaft Case State zur Auswahl steht, so wurde noch kein 
Vorgangs-Status für den Geschäftsprozess definiert. Die verfügbaren Vorgangs-
Statuswerte können Sie neben dem Wert von Eigenschaft Case State mit Klick auf 

 verwalten, siehe Vorgangs-Statuswerte verwalten.



Alternativ kann der Vorgangs-Status auch dynamisch über technische Prozesse 
gesetzt werden. Hierzu steht der Case Management Adapter zur Verfügung.



Alternativ zur Angabe einer Wartezeit lässt sich über Until ein Endzeitpunkt festlegen.
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3.

Unter Dynamic Configuration auf Create klicken. 

Prozessnamen eingeben und mit OK bestätigen.
Der Prozess wird nun unterhalb des BPM-Prozesses angelegt und kann hier weiter bearbeitet 
werden.

Der Prozess muss dabei folgende Zielstruktur liefern:

Beispielstruktur: Dauer

<timerBasedConfiguration>
    <durationDay>0</durationDay>
    <durationHour>0</durationHour>
    <durationMinute>0</durationMinute>
    <durationSecond>10</durationSecond>
    <durationMillis>0</durationMillis>
</timerBasedConfiguration> 

Beispielstruktur: Zeitpunkt

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<timerBasedConfiguration>
    <untilTimestamp>2020-03-17T17:00:00</untilTimestamp>
</timerBasedConfiguration>
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1.4.1.4 Non-Interrupting Intermediate Event

 Non-interrupting intermediate events: Definiert gemäß BPMN 2.0 ein beliebiges nicht-
unterbrechendes Zwischen-Ereignis (Non-interrupting Intermediate Event) innerhalb eines 
Geschäftsprozesses und ermöglicht die Unterscheidung hinsichtlich verschiedener Ereignistypen. Im 
Unterschied zu Intermediate Events wird bei einem Non-Interrupting Intermediate Event die 
Bearbeitung der Aktivität nicht unterbrochen, der durch das Ereignis eingeleitete Pfad wird parallel 
aktiviert und durchlaufen.

Eigenschaften

Docu
ment

Pfad zum entsprechenden Prozess im X4 Repository

Labe
l

Beschriftung des Symbols im Prozessdiagramm

Non-Interrupting Intermediate Events stehen lediglich im so genannten Free-flow mode des 
BPMN Editors zur Verfügung. Der Free-flow mode lässt sich beim Anlegen von BPM-
Prozessen aktivieren und bietet eine erweiterte Zeichen-Palette. Im Vergleich zum Standard-
Modus ist im Free-flow mode die Run/Debug-Funktion deaktiviert. Zudem lässt sich der 
Modus nachträglich nicht mehr verändern.


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Even
t

Ereignistyp

Mögliche Werte:

Non-Interrupting Message Intermediate (Catch): Eingehendes nicht-
unterbrechendes Nachrichten-Zwischen-Ereignis

Non-Interrupting Message Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Nachrichten-Zwischen-Ereignis

Non-Interrupting Escalation Intermediate (Catch): Eingehendes nicht-
unterbrechendes Eskalations-Zwischen-Ereignis

Non-Interrupting Escalation Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Eskalations-Zwischen-Ereignis

Non-Interrupting Multiple Intermediate (Catch): Eingehendes nicht-
unterbrechendes Mehrfach-Zwischen-Ereignis

Non-Interrupting Multiple Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Mehrfach-Zwischen-Ereignis

Non-Interrupting Conditional Intermediate: Nicht-unterbrechendes 
Geschäftsregel-Zwischen-Ereignis
Non-Interrupting Signal Intermediate (Catch): Eingehendes nicht-
unterbrechendes Signal-Zwischen-Ereignis

Non-Interrupting Signal Intermediate (Throw): Ausgehendes nicht-
unterbrechendes Signal-Zwischen-Ereignis

Non-Interrupting Timer Intermediate: Zeitgesteuertes nicht-unterbrechendes
Zwischen-Ereignis

Non-Interrupting Parallel Multiple Intermediate: Mehrfaches nicht-
unterbrechendes Parallel-Zwischen-Ereignis

1.4.1.5 End

 End: Definiert gemäß BPMN 2.0 ein End-Ereignis des Geschäftsprozesses.

Eigenschaften

Lab
el

Beschriftung des Symbols im Prozessdiagramm
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Eve
nt

Ereignistyp

Mögliche Werte:

None End: Allgemeines End-Ereignis (Standard)

Terminate End: Abbrechendes End-Ereignis (für alle Prozess-Instanzen)

Message End: Nachrichtenorientiertes End-Ereignis

Cancel End: Abbrechendes End-Ereignis (der laufenden Prozess-Instanz)
Compensation End: Kompensierendes End-Ereignis

Error End: End-Ereignis bei einem Fehler

Escalation End: Eskalierendes End-Ereignis

Multiple End: Mehrfaches End-Ereignis

Signal End: End-Ereignis, das einem Signal folgt

1.4.2 Activities

1.4.2.1 Activity

 Activity: Definiert gemäß BPMN 2.0 eine Aktivität innerhalb eines fachlichen 
Geschäftsprozesses. Der Aktivitätstyp sowie dessen Ausführungsverhalten wird durch 
entsprechende Eigenschaften festgelegt bzw. durch Marker gekennzeichnet. Mit einem Aktivitäts-
Baustein lassen sich je nach Anwendungsfall technische Prozesse oder weitere BPM-Prozesse als 
Subprozesse verknüpfen. 

Eigenschaften

Business
Ad hoc Markierung als Ad-hoc-Aktivität durch das Symbol 
Compensation Markierung als kompensierende Aktivität durch das Symbol 
Activity 
type

Kennzeichnung des Aktivitätstyps

Verfügbare Aktivitätstypen:

None: Allgemeine Aktivität, ohne zusätzliche Markierung (Standard)
 Send: Senden
 Receive: Empfangen
 Manual: Manuelle Aktivität
 Service: Dienst(prozess)
 Script: Skript
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Execution 
type

Kennzeichnung des Ausführungsverhaltens

Verfügbare Ausführverhaltens-Marker:

Single: Einfache Ausführung (Standard)
 Loop: Schleife
 Parallel Multi-Instance: Parallele Mehrfachausführung
 Sequential Multi-Instance: Sequenzielle Mehrfachausführung

Technical
Document Pfad zum verknüpften Prozess im X4 Repository (vom X4 Designer gesetzt). Wird ein 

Baustein-Symbol aus der Palette per Drag&Drop auf der Zeichnungsfläche 
eingefügt, so handelt es sich lediglich um einen leeren Prozessbaustein ohne Bezug 
zu einer Datei im Repository.

Label Beschriftung des Symbols im Prozessdiagramm

1.4.2.2 Human Task

 Human Task: Diese Aktivität ermöglicht die Konfiguration der Task Management Web App 
und damit die Interaktion mit von Menschen ausgeführten Aufgaben, die im Case Management als 
Vorgang modelliert werden, siehe Case Management – Vorgaenge und Workflows realisieren. 

Eigenschaften

Label Beschriftung des Symbols im Prozess-Diagramm

1.4.2.2.1 Human Tasks verwenden

Um menschliche Interaktionen in Geschäftsprozessen besser abzubilden, können bei der 
Modellierung von Geschäftsprozessen Human Tasks verwendet werden. Über einen Doppelklick auf 
den Human Task lässt sich der Human Task Editor öffnen. Er ermöglicht die Konfiguration der Task 
Management Web App.

Folgenden Einstellungen lassen sich vornehmen:

Title: Titel der Aufgabe in der Task Management Web App

Description: Optionale Beschreibung der Aufgabe
Registerkarte General: Besitzer, zugewiesenen Benutzer oder Gruppe und Frist für die 
Abarbeitung definieren

Die Markierung  (Teilprozess) wird automatisch gesetzt, sobald ein BPM-Subprozess 
(*.bpm) verknüpft ist.


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Owner: Besitzer der Aufgabe
Assigned User/Group: Zugewiesener Benutzer 
oder Gruppe für die Aufgabe

Deadline: Frist für die Abarbeitung der Aufgabe mit 
folgenden Optionen:

No deadline: Keine Frist
Duration: Dauer der Frist in Tagen, Stunden 
und Minuten
Until: Datum und Uhrzeit zu dem die 
Aufgabe abgearbeitet werden muss
Case State: Case State der automatisch 
ausgeführt wird, wenn die Frist des Human 
Tasks erreicht wurde

Registerkarte Business Data: Anzuzeigende Informationen für die Task Management Web App 
definieren

Die beteiligten Benutzer und Gruppen 
werden über das User Management im X4 
Control Center angelegt und verwaltet.



Wird ein Human Task mit einer 
festgelegten Frist ausgeführt, wird 
der Prozess automatisch mit dem 
konfigurierten Case State
fortgesetzt, nachdem die Frist 
erreicht wurde. Der Human Task wird 
in diesem Fall automatisch 
geschlossen und innerhalb der Task 
Management Web App im Navigator-
Ordner Verfallen angezeigt. Hier 
werden alle Human Tasks angezeigt, 
die die Frist überschritten haben und 
automatisch geschlossen worden 
sind.

Ist hingegen kein Case State gesetzt, 
wird der Prozess auch nicht 
automatisch fortgesetzt. 


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Key Identifier: Case-Feature als 
Schlüsselkennzeichnung in der Task 
Management Web App
Kategorien, Feature-Gruppen und Features 
werden in einer baumartigen Struktur angezeigt 
und können ausgewählt werden für die 
Sichtbarkeit in der Task Management Web App

 Kategorien werden als Tabs in der Task 
Management Web App angezeigt.
Display Name: Anzeigename der ausgewählten 
Kategorie, der Feature-Gruppe oder des 
Features
read only: Ausgewählte Kategorie, Feature-
Gruppe und Feature als schreibgeschützt 
kennzeichnen

Registerkarte Actions: Auszuführende Aktionen für die Task Management Web App definieren
Unter Actions können die Statuswerte 
angegeben werden, die vom Benutzer in der 
Task Management Web App für einen Vorgang 
gesetzt werden können
Display Name: Anzeigename des ausgewählten 
Case States in der Task Management Web App

Registerkarte Settings: Erweiterte Einstellungen für die Ver- und Bearbeitung von Vorgängen
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Im Bereich Advanced das Ablehnen und Weiterleiten von 
Tasks erlauben sowie den Zugriff auf Human Tasks über eine 
Schnittstelle erlauben, siehe

Über ReST-Schnittstelle auf Human Tasks zugreifen.
Task can be declined: Tasks können 
abgelehnt werden
Task can be forwarded: Tasks können 
weitergeleitet werden
Enable access via API: Den Zugriff auf des 
Task über eine Schnittstelle erlauben

Im Bereich Documents das Hinzufügen, Bearbeiten und 
Löschen von Dokumenten zu einem Vorgang erlauben. 

Enable Documents: Die Verarbeitung von 
Dokumenten erlauben 
Documents can be added/edited: 
Das Hinzufügen und Bearbeiten von 
Dokumenten erlauben
Documents can be deleted: Das Löschen von 
Dokumenten erlauben

Im Bereich Dynamic Configuration einen technischen 
Prozess anlegen, um den Human Task dynamisch zu 
parametrieren

Create: Technischen Prozess anlegen, siehe auch H
uman Task über technischen Prozess dynamisch 
parametrieren
Delete: Verknüpften technischen Prozess löschen 
Open: Verknüpften technischen Prozess öffnen

1.4.2.2.2 Human Task über technischen Prozess dynamisch parametrieren

Human Tasks lassen sich nicht nur über den Human Task Editor konfigurieren, sondern auch 
dynamisch über technische Prozesse. Der entsprechende Prozess wird über den Human Task Editor
angelegt und verwaltet.

Über den Task Management Adapter lassen sich 
zusätzliche Aktionen für einen Human Task 
definieren.



Ausführung auf dem X4 Server
Läuft ein BPM-Prozess während der Ausführung auf einen Human Task, wird die Ausführung 
des Prozesses angehalten und die menschlichen Aufgabe generiert. Der Prozess wartet auf 
die notwendige menschliche Interaktion innerhalb der Task Management Web App und setzt 
die Ausführung fort, sobald die menschliche Aufgabe zu dem Prozess abgeschlossen ist. 


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Folgende Einstellungen des Human Tasks lassen sich im Prozess übersteuern: 

Owner
Assignee
Deadline

Human Task Editor über Doppelklick auf den entsprechenden Human Task öffnen.
Die Registerkarte Settings öffnen.
Unter Dynamic Configuration auf Create klicken. 

Prozessnamen eingeben und mit OK bestätigen.
Der Prozess wird nun unterhalb des BPM-Prozesses angelegt und kann hier weiter bearbeitet 
werden.

Der technische Prozess zur Parametrierung des Human Tasks wird direkt unter dem 
entsprechenden BPM-Prozess angelegt und kann auch nicht verschoben werden.  



Das Input- und Output-Dokument für den Prozess sieht wie folgt aus:

Struktur des Input- und Output-Dokuments

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<HumanTask>
    <Owner>OwnerName</Owner>
    <Assignee>
        <name>AsigneeName</name>
        <type>user|group</type>
    </Assignee>
     
    <!-- Deadline types (NoDeadline, DurationDeadline, UntilDeadline)-->
    <NoDeadline />
 
    <DurationDeadline>
        <Days>7</Days>
        <Hours>4</Hours>
        <Minutes>45</Minutes>
    </DurationDeadline>
 
    <UntilDeadline>2019-04-18T14:30:49+02:00</UntilDeadline>
</HumanTask>


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1.4.2.2.3 Über ReST-Schnittstelle auf Human Tasks zugreifen

Anstelle der Task Management Web App können auch andere Anwendungen für die Anzeige und 
Bearbeitung von Human Tasks verwendet werden. Die Anbindung findet über eine Webservice-
basierte Schnittstelle statt, welche alle Funktionalitäten bietet, die auch in der Task Management 
Web App verfügbar sind.

Um die Anbindung über die ReST-Schnittstelle zu ermöglichen, müssen folgende Einstellungen im 
Human Task vorgenommen werden:

Human Task Editor über Doppelklick auf den entsprechenden Human Task öffnen.
Die Registerkarte Settings öffnen.
Im Bereich Advanced die Option Enable access via API wählen.
Der Zugriff ist nun ausschließlich über die Schnittstelle möglich.

1.4.2.3 Rule

 Rule: Mit dem Rule-Baustein werden Entscheidungstabellen nach DMN 1.1 in 
Geschäftsprozessen eingefügt und Regeln für Entscheidungen festgelegt. Die Regeln können 
automatisiert geprüft und die Ergebnisse für die Weiterverarbeitung an den Geschäftsprozess 

Der Zugriff auf den Human Task über die ReST-Schnittstelle kann pro Human Task ermöglicht 
werden.



Die Dokumentation der ReST-Schnittstelle kann unter http://localhost:8080/X4/services/
rest/openapi.yaml oder http://localhost:8080/X4/services/rest/openapi.json im OpenAPI 
3.0-Format abgerufen werden. 
Um die ReST-Schnittstelle zu nutzen, kann beispielsweise der Swagger Editor verwendet 
werden.



http://localhost:8080/X4/services/rest/openapi.yaml
http://localhost:8080/X4/services/rest/openapi.yaml
http://localhost:8080/X4/services/rest/openapi.json
https://editor.swagger.io/
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zurückzugeben werden.

Eigenschaften

Label Beschriftung des Symbols im Prozessdiagramm

1.4.2.3.1 Der DMN Decision Table Editor

Der DMN Decision Table Editor ist wie folgt aufgebaut:

Nr. Element Beschreibung
1 Werkzeugleiste Funktionen zum Bearbeiten von 

Entscheidungstabellen, abhängig von Kontext und 
Auswahl

DMN ist ein Standard zur Modellierung von Entscheidungen in Geschäftsprozessen. Im 
Standard DMN ist auch die Simple Expression Language (S-FEEL) definiert, eine formale 
Ausdruckssprache zur Definition einer Entscheidungslogik.
DMN 1.1 mit S-FEEL ist online verfügbar unter https://www.omg.org/spec/DMN/1.1/.



Über einen Doppelklick auf den Rule-Baustein im Prozess-Diagramm lässt sich der DMN 
Decision Table Editor öffnen. Im DMN Decision Table Editor können Entscheidungen als 
Entscheidungstabellen nach DMN 1.1 erstellt werden.



https://www.omg.org/spec/DMN/1.1/
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Nr. Element Beschreibung
2 Kopfbereich Einstellungen zur Definition von Input und Output; 

Mehrere Inputs und Outputs sind möglich

3 Annotation Freie Anmerkung, die nicht im Output ausgegeben 
wird

4 Regeln Regeln, die festlegen, wie Inputs zu Outputs 
transformiert werden sollen.

5 Hit Policy Einstellung zur Auswahl der Ergebnisse:

wie viele Regeln zutreffen können
wie die Ergebnisse ausgegeben werden

1.4.2.3.1.1 Die Werkzeugleiste des DMN Decision Table Editor

Im DMN Decision Table Editor stehen in der Werkzeugleiste je nach Kontext und Auswahl 
verschiedene Funktionen zum Bearbeiten von Entscheidungtabellen zur Verfügung.

Butt
on

Funktion Beschreibung

Add Input Input-Spalte (links) hinzufügen

Add Row Zeile oben hinzufügen

Add Output Output-Spalte (links) hinzufügen

Clear 
Selection

Auswahl aufheben

Move Up Markierte Zeile einen Schritt nach oben verschieben

Move Down Markierte Zeile einen Schritt nach unten verschieben

Add Before Zeile oberhalb hinzufügen

 Die Zeile muss hierzu markiert sein.

Remove 
Row

Markierte Zeile löschen

Add After Zeile unterhalb hinzufügen

 Die Zeile muss hierzu markiert sein.
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Butt
on

Funktion Beschreibung

Add Before Spalte links hinzufügen

 Die Spalte muss hierzu markiert sein.

Remove 
Column

Markierte Spalte löschen

Add After Spalte rechts hinzufügen

 Die Spalte muss hierzu markiert sein.

Move Left Markierte Spalte einen Schritt nach links verschieben

Move Right Markierte Spalte einen Schritt nach rechts verschieben

1.4.2.3.1.2 Input

Eine Entscheidungstabelle kann eine oder mehrere Input-Spalten haben. Input-Spalten bestehen aus 
folgenden zwei Teilen:

Kopfber
eich

Kopfbereich mit Zellen zur Definition des Inputs:

Freitextfeld für den Spalten-Namen
Input-Quelle mit folgender Auswahl

Input: Input aus dem BPMN-Prozess
Placeholder: Auswahl eines Platzhalters
Variable: in einer Variable hinterlegter Wert
Case State: Auswahl eines Status
Case Feature: Auswahl von Fachdaten

Datentyp des Inputs mit folgender Auswahl (je nach Input-Quelle):
string: Zeichenkette
number: Zahl
boolean: Boolesche Variable

Input-Pfad als Freitextfeld oder Auswahl (je nach Quelle des Inputs)

Regeln Nummerierten Zeilen mit Zellen zur Definition von Regeln für die Entscheidungsfindung

1.4.2.3.1.3 Output

Eine Entscheidungstabelle kann eine oder mehrere Output-Spalten haben. Output-Spalten bestehen 
aus folgenden zwei Teilen:

Achten Sie bei Pfaden auf eine korrekte Schreibweise.
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Kopfber
eich

Kopfbereich mit Zellen zur Definition des Outputs:

Freitextfeld für den Spalten-Namen
Output-Quelle mit folgender Auswahl

Output: Output an den BPMN-Prozess
Variable: in einer Variable hinterlegter Wert
Case State: Auswahl eines Status
Case Feature: Auswahl von Fachdaten

Datentyp des Outputs mit folgender Auswahl (je nach Output-Ziel):
string: Zeichenkette
number: Zahl
boolean: Boolesche Variable

Name des Outputs oder der Variable als Freitextfeld oder Auswahl (je nach Output-Ziel)

Regeln Nummerierten Zeilen mit Zellen zur Definition von Regeln für die Entscheidungsfindung

1.4.2.3.1.4 Annotation

Unter Annotation können freie Anmerkungen zu den jeweiligen Regeln hinterlegt werden. Annotations 
dienen lediglich der Verständlichkeit und werden nicht im Output ausgegeben.

1.4.2.3.1.5 Regeln

In der Entscheidungstabelle werden Regeln pro Zeile definiert. Eine Regel hat mindestens eine Spalte 
zur Verarbeitung der Eingangswerte (Input) und mindestens ein Entscheidungs-Ergebnis (Output).

Die Regeln in der Entscheidungstabelle werden in der S-FEEL-Notation angegeben. Damit lässt sich 
die Entscheidungslogik in natürlicher Sprache "business-friendly" beschreiben. Gleichzeitig erlaubt 
sie als formale Auszeichnungssprache mit festgelegter Semantik, Grammatik und definierten Regeln 
die Interpretation und das Ausführen von Werten. S-FEEL kann Zeichenketten, Zahlen, einfache 
arithmetische Operationen und simple Vergleichsprüfungen interpretieren.

S-FEEL-Ausdrücke zur Definition von Regeln:

Operator / 
Ausdruck

Beschreibung

Vergleic
h

10 Prüft, ob der Eingabewert gleich dem angegebenen Wert ist, z. B. 10

•
•

Beachten Sie:

Variablennamen ohne Leerzeichen verwenden, z. B. FreigabeDurch
Variablennamen und Pfade korrekt eingeben



Verkettung von Entscheidungstabellen
Es können beliebig viele Entscheidungstabellen in einem BPM-Prozess verkettet werden. 
Ausgangswerte der einen Tabelle werden somit zu Eingangswerten der nachfolgenden. 
Dadurch lassen sich komplexe Entscheidungsbäume mit entsprechenden 
Verzweigungen modellieren.


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v:
[Variab
lenname
]
f:
[Featur
ename]
p:
[Platzh
alterna
me]
c:
[CaseSt
ate]

Führt eine Prüfung auf Basis einer Variablen, eines Features, eines 
benutzerdefinierten Platzhalters oder eines Vorgangs-Statuswertes 
(Case State) durch

< Prüft, ob der Eingabewert kleiner als der angegebene Wert ist, z. B. < 10

<= Prüft, ob der Eingabewert kleiner oder gleich dem angegebenen Wert ist, 
z. B. <= 10

> Prüft, ob der Eingabewert größer dem angegebenen Wert ist, z. B. > 10
>= Prüft, ob der Eingabewert größer oder gleich dem angegebenen Wert ist, 

z. B. >= 10
not() Prüft, ob der Eingabewert nicht kleiner oder gleich dem angegebenen 

Wert ist, z. B. not(<=10)

Intervall [1..10] Prüft, ob der der Eingabewert größer oder gleich dem Startwert und 
kleiner oder gleich dem Endwert ist

(1..10] Prüft, ob der Eingabewert größer als der Startwert und kleiner oder gleich 
dem Endwert ist

[1..10) Prüft, ob der Eingabewert größer oder gleich dem Startwert und kleiner 
als der Endwert ist

(1..10) Prüft, ob der Eingabewert größer als der Startwert und kleiner als der 
Endwert ist

Disjunkti
on

3,5,7 Prüft, ob der der Eingabewert 3,5 oder 7 ist

<2,>10 Prüft, ob der Eingabewert weniger als 2 oder mehr als 10 ist
10,[20..30] Prüft, ob der Eingabewert entweder 10 oder zwischen 20 und 30 ist
"Meier", 
"Müller, 
"Weber"

Prüft, ob der Eingabewert entweder Meier, Müller oder Weber ist

1.4.2.3.1.6 Hit Policy

Die Hit Policy ist eine Einstellung zur Auswahl der Ergebnisse. Sie legt fest, wie viele Regeln einer 
Entscheidungstabelle zutreffen können und wie die Ergebnisse ausgegeben werden.

Mit Strg + Leertaste lassen sich alle aktuell verfügbaren 
Variablen, Features, Benutzerdefinierten Platzhalter und 
Vorgangs-Statuswerte in einer Auswahlliste aufrufen.



Eine umfangreiche Referenz zur Syntax der S-FEEL Notation finden Sie in der aktuelle 
Spezifikation zu DMN 1.1 (Kapitel 9) der Object Management Group. https://www.omg.org/
spec/DMN/1.1 



https://www.omg.org/spec/DMN/1.1
https://www.omg.org/spec/DMN/1.1
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1.
2.
3.

4.

5.
•
•
•
•

6.

Ausw
ahl

Bedeutung Möglicher Verstoß gegen die Hit 
Policy

U Unique: Nur eine Regel kann zutreffen und es wird genau 
ein Ergebnis ausgegeben.

Keine zutreffende Regel
Mehrere zutreffende 
Regeln

F First: Eine oder mehrere Regeln können zutreffen, es wird 
aber nur das erste Ergebnis ausgegeben.

 Überprüfungsreihenfolge beachten!

Keine zutreffende Regel

A Any: Eine oder mehrere Regeln mit demselben Ergebnis 
können zutreffen, es wird jedoch nur ein Ergebnis 
ausgegeben.

Keine zutreffende Regel
Mehrere zutreffende 
Regeln mit 
unterschiedlichen 
Ergebnissen

C Collect: Alle zutreffenden Ergebnisse werden ohne feste 
Ausgabereihenfolge ausgegeben.

Keine zutreffende Regel

1.4.2.3.2 Entscheidungstabellen anlegen

BPM-Prozess über New > BPM Process anlegen.
Prozess wie gewohnt modellieren.
Rule-Baustein aus der Palette per Drag&Drop auf die Zeichnungsfläche ziehen.

Rule-Baustein doppelklicken, um die Entscheidungstabelle im DMN Decision Table Editor zu 
öffnen.
Beliebig viele Input-Spalten definieren:

Spalten-Namen angeben
Input-Quelle per Doppelklick wählen
Datentyp des Inputs per Doppelklick wählen
Input-Pfad angeben

Beliebig viele Output-Spalten definieren:

Regeln können so definiert werden, dass die Anzahl und Auswahl der Ergebnisse gegen die Hit 
Policy verstößt. In diesem Fall müssen je nach Anwendungsfall die Regeln oder die Hit Policy 
korrigiert werden.



Verkettung von Entscheidungstabellen
Es können beliebig viele Entscheidungstabellen in einem BPM-Prozess verkettet 
werden. Ausgangswerte der einen Tabelle werden somit zu Eingangswerten der 
nachfolgenden. Dadurch lassen sich komplexe Entscheidungsbäume mit 
entsprechenden Verzweigungen modellieren.



•

•

Für die Bearbeitung von Input-Spalten stehen folgende Optionen zur Verfügung:
Spalte   links oder   rechts von einer markierten Spalte hinzufügen

Markierte Spalte nach   links oder   rechts oder per Drag&Drop verschieben


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•
•
•
•

7.

8.
9.

10.

Spalten-Namen angeben
Output-Quelle per Doppelklick wählen
Datentyp des Outputs per Doppelklick wählen
Name des Outputs oder der Variable angeben

Regeln festlegen. 
Dazu beliebig viele Zeilen anlegen und in jeder Zelle einen entsprechenden Wert angeben, der 
konform zu S-FEEL ist.

Hit Policy definieren.
Ggf. zu jeder Regel eine Annotation mit einem kurzen Erläuterungstext hinzufügen.
Um alle Eingaben zu speichern und das Fenster zu schließen, OK klicken.

•

•

Für die Bearbeitung von Output-Spalten stehen folgende Optionen zur Verfügung:
Spalte   links oder   rechts von einer markierten Spalte hinzufügen

Markierte Spalte nach   links oder   rechts oder per Drag&Drop verschieben



Für jede Regel wird in der Entscheidungstabelle eine Zeile benötigt. Die Reihenfolge 
der Zeilen gibt die Überprüfungsreihenfolge vor. Die Überprüfungsreihenfolge ist je 
nach Hit Policy relevant.



•
•
•

•

Beachten Sie:
Zeichenketten in Anführungszeichen setzen, z. B. "Abteilungsleiter"
Für Dezimalzahlen einen Punkt als Trennzeichen verwenden, z. B. 5.1
Ist der Wert einer Zelle der Input-Spalte nicht für eine Regel relevant, 
entsprechend S-FEEL ein - (Minuszeichen) in die Zelle eingeben
Eine Entscheidungstabelle kann eine Fallback-Regel enthalten, die immer 
zutreffen soll. Hierzu enthalten alle Zellen der Input-Spalten einer Fallback-Regel 
ein - (Minuszeichen).
Ob eine Fallback-Regel sinnvoll ist und an welcher Stelle der 
Überprüfungsreihenfolge sie stehen sollte, hängt von der Hit Policy und dem 
Anwendungsfall ab.



•
•

•

Für die Bearbeitung der Zeilen stehen folgende Optionen zur Verfügung:
Zeile  oberhalb oder   unterhalb einer markierten Zeile hinzufügen
Markierte Zeile mit  löschen

Markierte Zeile nach   oben oder   unten oder per Drag&Drop verschieben


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•

•

•

1.4.3 Sequence Flow

 Sequence Flow: Verbindet in einem Geschäftsprozess die einzelnen Events, Gateways und 
Activities und definiert die Reihenfolge der Prozess-Schritte durch seine Pfeilrichtung.

Eigenschaften

Label Freitextfeld zur Beschriftung der Sequenzfluss-Linie (zur übersichtlicheren Gestaltung 
bzw. Dokumentation)

Log4J Log Logging über Log4j an dieser Stelle des Prozesses mit den aktuellen Input-Daten 
aktivieren; Um das Logging über Log4j zu aktivieren, die Eigenschaft markieren und 
auf  klicken.

Mögliche Werte:

Disabled: Keine Log4j-Aktion wurde festgelegt (Standard)

Enabled: Eine Log4j-Aktion wurde festgelegt

BAM Log Logging über X4 BAM an dieser Stelle des Prozesses mit den aktuellen Input-Daten 
aktivieren; Um BAM-Logging zu aktivieren, die Eigenschaft markieren und auf 
klicken.

Mögliche Werte:

Disabled: Keine BAM-Logging-Aktion wurde festgelegt (Standard)

Enabled: Eine BAM-Logging-Aktion wurde festgelegt

•
•
•

Der fertige BPMN-Prozess mit der Entscheidungstabelle kann im X4 Designer validiert, 
auf Fehler überprüft und auf dem X4 Server ausgeführt werden.
Entscheidungstabellen können zu drei Ergebnissen führen:
Icon Beschreibung

Der Rule-Baustein liefert ein oder mehrere Ergebnisse. Das 
Zwischenergebnis ist aufrufbar.

Der Rule-Baustein liefert keine Ergebnisse. Mögliche Ursachen:

Für den Input gilt keine der definierten Regeln
Regeln fehlerhaft, z. B. Schreibfehler
Hit Policy nicht geeignet

Der Rule-Baustein liefert einen Fehler, da die 
Entscheidungstabelle nicht konform zu S-FEEL ist. Ein Bericht mit 
einer Erklärung des Fehlers ist aufrufbar.


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Save Point Save Point an dieser Stelle des Prozesses setzen, um den kompletten Zustand der 
Prozess-Engine mit den verarbeiteten Daten und Statusinformationen bei der 
Ausführung einer Prozess-Instanz im Dateisystem zu persistieren. Die Prozess-Instanz 
kann vom letzen gespeicherten Save Point über X4 BAM wiederaufgesetzt werden.

Mögliche Werte:

No Savepoint: Kein Save Point wurde festgelegt (Standard)

Save and Continue: Save Point erstellen und die Prozess-Ausführung direkt 
fortsetzen

Save and Stop: Save Point erstellen und die Ausführung der Prozess-Instanz 
anhalten

Delete: aktuellen Save Point löschen

Priority Bei Gabelungen (Parallel Gateways (Forking)) und Verzweigungen (Exclusive 
Gateways (Forking)): Position in der Ausführreihenfolge (Priorität)

Mögliche Werte:

Beliebige positive ganze Zahl

1: Höchste Priorität (Standard)

Condition Bei Bedingungs-Bausteinen: vom Condition Manager hinterlegte Ausführ-Bedingung

1.4.4 Gateways
Innerhalb von fachlichen Prozessen (Prozessdiagramme mit der Dateiendung .bpm) können Sie 
folgende Gateways gemäß BPMN 2.0 verwenden:

1.4.4.1 Parallel Gateways

Parallel Gateway 
(Forking)

Definiert gemäß BPMN 2.0 ein paralleles Gateway für logische 
UND-Verzweigungen

Parallel Gateway 
(Synchronizing)

Definiert gemäß BPMN 2.0 ein synchronisierendes Gateway für die 
Zusammenführung von parallelen Sequenzflüssen

Eigenschaften

Labe
l

Freitextfeld zur Beschriftung der Verzweigung bzw. der Zusammenführung (zur 
übersichtlicheren Gestaltung bzw. Dokumentation)

Parallel Gateways verwenden

Wenn Sequenzflüsse mit Parallel Gateways "parallel" modelliert wurden, bedeutet dies keine 
gleichzeitige, sondern vielmehr eine gleichberechtigte Ausführung. Die tatsächliche 
Ausführreihenfolge der parallel geführten Sequenzflüsse können Sie über deren Priorität (in 
Eigenschaft Priority) festlegen, siehe Sequence Flow.


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1.

2.

3.

4.

5.

Parallel Gateway (Forking)-Element aus der Palette per Drag&Drop ins Prozessdiagramm 
ziehen.
Für jeden Ausführungszweig eine Sequence Flow-Linie ausgehend vom Parallel Gateway 
(Forking)-Element erstellen.
Alle Ausführungszweige werden nun unabhängig voneinander ausgeführt und besitzen 
denselben Input.
Falls gewünscht, über die Eigenschaft Priority der markierten Sequence Flow-Linie die 
Ausführreihenfolge der einzelnen Ausführungszweige verändern.

Parallel Gateway (Synchronizing)-Element aus der Palette per Drag&Drop in ein 
Prozessdiagramm ziehen.
Sequence Flow-Linien der Ausführungszweige mit dem Parallel Gateway 
(Synchronizing)-Element verbinden.
In ausführbaren Prozessen wird das Ausgabe-Dokumente des letzten ausgeführten Elements 
innerhalb der Gabelung an den nächsten Prozess-Schritt weitergegeben.

Beispiel: Parallel Gateway (Forking) mit 3 parallelen, priorisierten Verzweigungen und Parallel Gateway 
(Join):

1.4.4.2 Inclusive Gateways

Inclusive 
Gateway 
(Forking)

Definiert gemäß BPMN 2.0 ein datenbasiertes inklusives Gateway für logische 
ODER-Verzweigungen

Inclusive 
Gateway 
(Synchronizing
)

Definiert gemäß BPMN 2.0 ein synchronisierendes Gateway für die 
Zusammenführung von inklusiven datenbasierten Sequenzflüssen

Eigenschaften

In ausführbaren Prozessen werden die Ausführungszweige mit der niedrigsten Wert in P
riority zuerst ausgeführt.



Inclusive Gateways führen in der Praxis schnell zu wenig sinnvollen Konstrukten. Daher 
empfehlen BPM-Experten wie Jakob Freund, Bernd Rücker und Thomas Henninger im 
Praxishandbuch BPMN (ISBN: 978-3-446-41768-7), diese Elemente sparsam zu verwenden 
und stattdessen Exclusive- und Parallel Gateways zu kombinieren.


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1.

2.

3.

Labe
l

Freitextfeld zur Beschriftung der Verzweigung bzw. der Zusammenführung (zur 
übersichtlicheren Gestaltung bzw. Dokumentation)

Cond
itio
n

Ausführ-Bedingung (wird vom Condition Editor automatisch gesetzt) für die Verzweigung 
(Forking).

Auf die Übergangslinie doppelklicken, um Bedingungen zu hinterlegen oder auf   klicken, 
um den Condition Editor zu öffnen.

Beispiel: Inclusive Gateway (Forking) mit 3 inklusiven Verzweigungen und synchronisierendem 
Inclusive Gateway (Synchronizing)

1.4.4.3 Exclusive Gateways

Exclusive Gateway 
(Forking)

Definiert gemäß BPMN 2.0 ein Gateway für exklusive Verzweigungen

Exclusive Gateway 
(Synchronizing)

Definiert gemäß BPMN 2.0 ein synchronisierendes Gateway für die 
Zusammenführung von exklusiven datenbasierten Sequenzflüssen

Eigenschaften

Label Freitextfeld zur Beschriftung des exklusiven Verzweigung bzw. 
Zusammenführung (zur übersichtlicheren Gestaltung bzw. 
Dokumentation)

Condition Ausführ-Bedingung der Verzweigung (wird vom Condition Editor
automatisch gesetzt); auf die Übergangslinie doppelklicken, um 
Bedingungen zu hinterlegen oder auf  klicken, um den Condition 
Editor zu öffnen.

Exklusive Gateways verwenden

Exclusive Gateway (Forking)-Element aus der Palette per Drag&Drop ins Prozessdiagramm 
ziehen.
Für jeden Ausführungszweig eine Sequence Flow-Linie ausgehend vom Exclusive Gateway 
(Forking)-Element erstellen.
Alle Ausführungszweige besitzen denselben Input.
Exclusive Gateway (Forking)-Element doppelklicken, um die Bedingungen für die einzelnen 
Ausführungszweige festzulegen.
Der Condition Editor wird geöffnet. In diesem Editor können Sie für jede 
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4.

5.

6.

ausgewählte Sequence Flow-Linie eine Bedingung definieren, siehe Bedingungen erstellen und 
verwenden.
Falls gewünscht, über die Eigenschaft Priority der markierten Sequence Flow-Linie die 
Ausführreihenfolge der einzelnen Ausführungszweige verändern.

Exclusive Gateway (Synchronizing)-Element aus der Palette per Drag&Drop ins 
Prozessdiagramm ziehen.
Sequence Flow-Linien der Ausführungszweige mit dem Exclusive Gateway 
(Synchronizing)-Element verbinden.
In ausführbaren Prozessen wird das Ausgabe-Dokument des letzten ausgeführten Elements 
innerhalb der Gabelung an den nächsten Prozess-Schritt wie in technischen Prozessen 
weitergegeben.

Beispiel: Exclusive Gateway (Forking) mit 3 exklusiven Verzweigungen und synchronisierendem 
Exclusive Gateway (Synchronizing):

1.4.5 Artefakte
Innerhalb von fachlichen Prozessen (Prozessdiagramme mit der Dateiendung .bpm) können Sie 
folgende Artefakte gemäß BPMN 2.0 verwenden:

1.4.5.1 Message Flow

 Message Flow: Werden mehrere Pools verwendet, um eine Zusammenarbeit zwischen 
verschiedenen Partnern zu modellieren, wird der Informationsaustausch zwischen diesen Pools mit 
Nachrichtenflüssen gekennzeichnet.

In ausführbaren Prozessen werden die Ausführungszweige mit der niedrigsten Wert in P
riority zuerst ausgeführt.



Da Geschäftsprozesse im BPMN-Standard keine Variable-Bausteine enthalten, können 
Kontextvariablen mit Exclusive Gateways nur ausgewertet werden, wenn die 
Kontextvariablen innerhalb von technischen Prozessen definiert wurden und diese 
technischen Prozesse als Aktivität im Geschäftsprozess verknüpft wurden. Hierzu stehen im 
Geschäftsprozess Kontextvariablen zur Verfügung, die in verknüpften technischen 
Prozessen, nicht aber etwaigen Subprozessen dieser technischen Prozesse, initialisiert 
wurden.


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•

•

•

•

•

Eigenschaften

Label Freitextfeld zur Beschriftung des Nachrichtenflusses (zur übersichtlicheren 
Gestaltung bzw. Dokumentation)

Line 
Routing

Linienführung

Mögliche Werte:

Angled: Angewinkelte Linie

Straight: Gerade Linie (Standard)

Line Type Linienstil

Mögliche Werte:

Dash line: Gestrichelte Linie (Standard)

Solid line: Durchgezogene Linie

Dot line: Gepunktete Linie

Line Color Farbe des Nachrichtenflusses; Um die Farbe zu ändern, die Eigenschaft markieren 
und auf  klicken.

Mögliche Werte:

 RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

 RGB(0,0,0): Schwarz (Standard)

Beachten Sie, dass Nachrichtenflüsse ausschließlich zur Visualisierung von logischen 
Zusammenhängen dienen!
Bei der Ausführung des Geschäftsprozesses über den X4 Server werden ausschließlich 
Prozessbausteine in den Daten- und Kontrollfluss mit einbezogen, die über Sequenzfluss-
Linien verbunden sind, siehe Sequence Flow.


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Line 
Source 
Decorator

und Line 
Target 
Decorator

Symbol für den Linienanfang und das Linienende

Mögliche Werte:

Circle: Kreis/Ellipse (Standard)

Empty arrow: Ungefüllter Pfeil

Association arrow: Offener Pfeil

Arrow: Gefüllter Pfeil

Inverted arrow: Umgekehrter Pfeil

Diamond: Gefüllte Raute

Empty diamond: Ungefüllte Raute

Plain: Kein Symbol

1.4.5.2 Association

 Association: Logische Verbindung innerhalb von BPM-Prozessen zwischen Prozessbausteinen 
(Events, Gateways oder Activities) und Artefakten (Pools, Data Objects, Annotations oder Groups) 
oder Zeichnungselementen. Dient vor allem zu Dokumentationszwecken.

Eigenschaften

Label Freitextfeld zur Beschriftung der Assoziations-Linie (zur übersichtlicheren 
Gestaltung bzw. Dokumentation)

Line Routing Linienführung

Mögliche Werte:

Angled: Angewinkelte Linie

Straight: Gerade Linie (Standard)

Line Type Linienstil

Mögliche Werte:

Dash line: Gestrichelte Linie (Standard)

Solid line: Durchgezogene Linie

Dot line: Gepunktete Linie

Beachten Sie, dass Assoziations-Linien ausschließlich zur Visualisierung von logischen 
Zusammenhängen dienen!
Bei der Ausführung des Geschäftsprozesses über den X4 Server werden ausschließlich 
Prozessbausteine in den Daten- und Kontrollfluss mit einbezogen, die über Sequenzfluss-
Linien verbunden sind, siehe Sequence Flow.


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Line Color Farbe der Assoziations-Linie; Um die Farbe zu ändern, die Eigenschaft markieren 
und auf  klicken.

Mögliche Werte:

 RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

 RGB(0,0,0): Schwarz (Standard)

Line Source 
Decorator und 
Line Target 
Decorator

Symbol für den Linienanfang und das Linienende

Mögliche Werte:

Circle: Kreis/Ellipse (Standard)

Empty arrow: Ungefüllter Pfeil

Association arrow: Offener Pfeil

Arrow: Gefüllter Pfeil

Inverted arrow: Umgekehrter Pfeil

Diamond : Gefüllte Raute

Empty diamond: Ungefüllte Raute

Plain : Kein Symbol

1.4.5.3 Pool/Lane

 Pool/Lane: Gliedert gemäß BPMN 2.0 einen Geschäftsprozess in Zuständigkeiten und 
Beteiligte. Lanes werden innerhalb eines oder mehrerer sogenannter Pools definiert und 
repräsentieren somit Zuständigkeiten von Aktivitäten. Mit Pools werden die beteiligten 
Organisationen, Systeme u. a. dargestellt, wobei ein Pool beliebig viele Lanes enthalten kann. In der 
Pool/Lane-Darstellung wird der zeitliche Prozessablauf zumeist von links oben nach rechts unten 
angeordnet.

Eigenschaften

Pool 
Name

Freitextname des Pools (wenn ein Pool markiert ist)

Lane 
Name

Freitextname der Lane (wenn eine Lane markiert ist)

Line 
Color

Linienfarbe des Pools oder der markierten Lane; Um die Farbe zu ändern, die 
Eigenschaft markieren und auf  klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(0,0,0): Schwarz (Standard)
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•

2.
•
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Line 
Width

Linienbreite des Pools oder der markierten Lane in Pixel

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

Fill 
Color

Füllfarbe des Pools oder der markierten Lane; Um die Farbe zu ändern, die Eigenschaft 
markieren und auf  klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(255, 255, 255): Weiß (Standard)

Pools und Lanes in Geschäftsprozessen verwenden

Mit Pools werden die beteiligten Organisationen, Systeme u. a. dargestellt, wobei ein Pool beliebig 
viele Lanes enthalten kann. In der Pool/Lane-Darstellung wird der zeitliche Prozessablauf zumeist von 
links oben nach rechts unten angeordnet.

Pool einfügen und bearbeiten:

Aus der Palette das Pool-Symbol   per Drag&Drop auf die Zeichnungsfläche ziehen.
Per Klick den Pool verschieben oder durch Ziehen der Eckpunkte beliebig skalieren.
Beschriftung des markierten Pools ändern: In der Properties-Sicht in Pool Name einen 
anderen Text eingeben.
Formatierung ändern: In der Properties-Sicht in Fill Color oder Line Color die 
Füllfarbe oder die Linienfarbe auswählen und auf   klicken, um eine Farbpalette 
aufzurufen.

Lane zu einem Pool hinzufügen:
Auf einen Pool rechtsklicken und aus dem Kontextmenü Add Lane wählen.
Beschriftung der markierten Lane ändern: In der Properties-Sicht in der 
Eigenschaft Lane Name einen anderen Text eingeben.
Hintergrundfarbe oder Linienfarbe ändern: In der Properties-Sicht die Eigenschaft Fill 
Color bzw. Line Color auswählen und auf   klicken, um eine Farbpalette aufzurufen.

1.4.5.4 Data Object

 Data Object: Bindet ein beliebiges Daten-Objekt ein, z. B. eine Datei aus dem X4 Repository.

Eigenschaften

Docu
ment

Pfad zum verknüpften Dokument im Repository.

Labe
l

Beschriftung des Symbols im Prozess-Diagramm
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Oper
atio
n

Bestimmt, ob die Datei gelesen oder geschrieben werden soll

Mögliche Werte:

Read: Dokument in den Prozess einlesen und Daten an den nächsten Prozess-Schritt 
weitergeben (Standard)

Write: Dokument mit den Daten aus dem vorangegangenen Prozess-Schritt speichern

1.4.5.5 Data Store

 Data Store: Dient zur Visualisierung einer verwendeten Datenbank.

Eigenschaften

Docu
ment

Pfad zum verknüpften Dokument im Repository.

Labe
l

Beschriftung des Symbols im Prozess-Diagramm

Oper
atio
n

Bestimmt, ob die Datei gelesen oder geschrieben werden soll

Mögliche Werte:

Read: Dokument in den Prozess einlesen und Daten an den nächsten Prozess-Schritt 
weitergeben (Standard)

Write: Dokument mit den Daten aus dem vorangegangenen Prozess-Schritt speichern

1.4.5.6 Annotation

 Annotation: Fügt eine freie Anmerkung ein, deren Text Sie per Doppelklick in einem 
Dialogfenster bearbeiten und formatieren können.

Eigenschaften

Hyperl
ink

Hinterlegte Verlinkung für die Anmerkung. Zum Verlinken eine gültige URL eintragen.

 Mit Strg+Klick lässt sich die eingetragene URL aufrufen.

Text Textinhalt der freien Anmerkung; Um den Text zu ändern und zu formatieren, die 
Eigenschaft markieren und auf  klicken.

Beachten Sie, dass Datenspeicher ausschließlich zur Visualisierung von logischen 
Zusammenhängen dienen!



Mit einer Association-Linie können Sie die Annotation mit einem Prozessbaustein logisch 
verbinden.


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Fill 
Color

Füllfarbe der Anmerkung; Um die Farbe zu ändern, die Eigenschaft markieren und auf 
 klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(255, 255, 255): Weiß (Standard)

Transp
arent

Anmerkungsfläche als transparent setzen. Durch Aktivieren der Eigenschaft, wird die 
Eigenschaft Fill Color aufgehoben.

1.4.5.7 Group

 Group: Fasst Elemente optisch zusammen, um zusammengehörige Gruppen zu visualisieren.

Eigenschaften

Line 
Color

Linienfarbe der Gruppe; um die Farbe zu ändern, die Eigenschaft markieren und auf 
klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(160,160,160): Grau (Standard)

Line 
Width

Linienbreite des Gruppenelements

Mögliche Werte:

Beliebige positive ganze Zahl

2: 2 Pixel breite, gestrichtelte Linie (Standard)

1.4.6 Drawing
Folgende Zeichnungselemente können Sie in sämtlichen Prozesstypen verwenden:

1.4.6.1 Connection

Connection: Verbindungsbaustein: Gibt den Input aus dem vorangegangenen Prozess-Schritt 
ebenso wie dessen Status unverändert aus. Es markiert den jeweiligen Ausführungszweig für den X4 
Server eindeutig. So lässt sich mit diesem Baustein in Schleifen der Rücksprung zum ersten 
Schleifenbaustein explizit setzen. Es verbindet einen Condition-Baustein mit einem Stop-Baustein 
oder hilft dabei die Positionierung einer Verbindung explizit zu verändern.
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1.4.6.1.1 Eigenschaften

Label Beschriftung des Symbols im Prozess-Diagramm (lässt sich dort auch 
über die F2-Taste bearbeiten)

Beispiele

Connection zwischen Condition und Schleifenrücksprung: Bei Schleifenrücksprüngen wird als 
letzter Schleifenbaustein ein Connection-Baustein gesetzt.

Connection zwischen Condition und Stop: Zwischen einem Condition-Baustein und 
einem Stop-Baustein wird ein Connection-Baustein gesetzt.

Connection zum Positionieren von Verbindungslinien: Verbindungslinien werden 
normalerweise automatisch positioniert. Um die Positionierung explizit zu verändern, können 
Verbindunsbausteine eingesetzt werden.

1.4.6.2 Connector

Connector: Ermöglicht die logische Verbindung von beliebigen Elementen.
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Eigenschaften

Label Freitextfeld zur Beschriftung der Verbindungslinie (zur übersichtlicheren 
Gestaltung bzw. Dokumentation)

Line Routing Linienführung

Mögliche Werte:

Angled: Angewinkelte Linie

Straight: Gerade Linie (Standard)

Line Type Linientyp

Mögliche Werte:

Dash line: Gestrichelte Linie (Standard)

Solid line: Durchgezogene Linie

Dot line: Gepunktete Linie

Line Color Farbe der Verbindungslinie; Um die Farbe zu ändern, die Eigenschaft markieren 
und auf  klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(0,0,0): Schwarz (Standard)

Connector-Verbindungslinien ausschließlich zur Visualisierung von logischen 
Zusammenhängen!
Bei der Ausführung des Geschäftsprozesses über den X4 Server werden ausschließlich 
Prozessbausteine in den Daten- und Kontrollfluss mit einbezogen, die in BPM-Prozessen über 
Sequenzfluss-Linien, siehe Sequence Flow, bzw. in X4-Prozessen über 
Transition-Übergangslinien verbunden sind, siehe Transition.


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Line Source 
Decorator und 
Line Target 
Decorator

Symbol für den Linienanfang

Mögliche Werte:

Circle: Kreis (Standard)

Empty arrow: Ungefüllter Pfeil

Association arrow: Offener Pfeil

Arrow: Gefüllter Pfeil

Inverted arrow: Umgekehrter Pfeil

Diamond: Gefüllte Raute

Empty diamond: Ungefüllte Raute

Plain: Kein Symbol

1.4.6.3 Rectangle und Ellipse

 Rectangle
Zeichnet ein beliebiges Rechteck

 Ellipse
Zeichnet eine beliebige Ellipse

Eigenschaften

Line Color Rahmenfarbe; um die Farbe zu ändern, die Eigenschaft markieren und auf 
klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(0,0,0): Schwarz (Standard)

Line Width Linienbreite des Zeichnungselements

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

Hide Line Rahmenlinie ausblenden
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Fill Color Füllfarbe des Zeichnungselements; Um die Farbe zu ändern, die Eigenschaft 
markieren und auf   klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(255, 255, 255): Weiß (Standard)

Transparent Zeichnungselements als transparent kennzeichnen. Durch Aktivieren der 
Eigenschaft, wird die Eigenschaft Fill Color aufgehoben.

1.4.6.4 Textbox

 Textbox: Fügt einen Textrahmen ein, dessen Inhalt Sie per Doppelklick in einem Dialogfenster 
bearbeiten und formatieren können.

Eigenschaften

Hyperlink Hinterlegte Verlinkung für das Textfeld. Zum Verlinken eine gültige URL eintragen.
 Mit Strg + Klick lässt sich die eingetragene URL aufrufen.

Text Inhalt des Textrahmens; um den Text zu ändern und zu formatieren, die Eigenschaft 
markieren und auf  klicken.

Rotation Drehung des Textrahmens

Mögliche Werte:

0: Keine Drehung (Standard)

90: Um 90° gegen den Uhrzeigersinn drehen

180: Um 180° drehen

270: Um 270° gegen den Uhrzeigersinn drehen

Fill Color Füllfarbe des Textfeldes; Um die Farbe zu ändern, die Eigenschaft markieren und auf 
 klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(255, 255, 255): Weiß (Standard)

Transparen
t

Textfeld als transparent setzen. Durch Aktivieren der Eigenschaft, wird die 
Eigenschaft Fill Color aufgehoben.
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1.4.6.5 Polygon

Polygon: Zeichnet ein Polygon mit beliebig vielen Eckpunkten.

Eigenschaften

Line Color Rahmenfarbe; um die Farbe zu ändern, die Eigenschaft markieren und auf 
klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(0,0,0): Schwarz (Standard)

Line Width Linienbreite des Zeichnungselements

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

Fill Color Füllfarbe des Zeichnungselements; um die Farbe zu ändern, die Eigenschaft 
markieren und auf  klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog 
wählbar)

RGB(255,255,255): Weiß (Standard)

Transparent Transparente Füllung (keine Füllfarbe verwenden). Durch Aktivieren der 
Eigenschaft, wird die Eigenschaft Fill Color aufgehoben.

1.4.6.6 Polyline und Line

 
Polyline

Zeichnet eine Linie mit beliebig vielen Wegpunkten

 Line
Zeichnet eine gerade Linie

Eigenschaften
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Line 
Color

Linienfarbe; um die Farbe zu ändern, die Eigenschaft markieren und auf   klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(0,0,0): Schwarz (Standard)

Line 
Width

Linienbreite des Zeichnungselements

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

1.4.6.7 Image

 Image: Fügt einen Bildrahmen ein, mit dem sich eine Grafikdatei vom Typ .gif, .jpg, .png 
oder .bmp einbinden lässt.

Eigenschaften

Line 
Color

Linienfarbe des Bildrahmens; Um die Farbe zu ändern, die Eigenschaft markieren und 
auf   klicken.

Mögliche Werte:

RGB(RRR,GGG,BBB): 24-bit-RGB-Farbcode (über den Farbauswahldialog wählbar)

RGB(0,0,0): Schwarz (Standard)

Line 
Width

Linienbreite des Zeichnungselements

Mögliche Werte:

Beliebige positive ganze Zahl

1: 1 Pixel breite Linie (Standard)

Image 
File

Pfad der verknüpften Grafikdatei

Das eingefügte Bild wird im Prozess gespeichert.
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2 Mit BPM-Projekten arbeiten
Das X4 Repository ist in Projekten organisiert. Projekte besitzen eine Dateisystem-Struktur und 
können beliebige Ordner, Prozesse, Prozessbausteine und andere Dateien enthalten.

2.1 Die Struktur von BPM-Projekten
BPM-Projekte haben eine vordefinierte und nicht veränderbare Ordnerstruktur, die beim Anlegen 
eines neuen BPM-Projektes automatisch angelegt wird. 

Projekt Auf oberster Ebene des Projektes lassen sich sowohl Webservice-
Konfigurationsdateien (.wsinc) als auch Prozesslandkarten (.pld) 
erstellen.

Processes Innerhalb des Processes-Ordners können beliebig viele BPM-
Prozesse (.bpm) angelegt werden. Hier ist ebenfalls der 
Activities-Ordner mit seiner vordefinierten Struktur enthalten.

Activities Der Activities-Ordner enthält folgende Unterordner, die jeweils 
nur vordefinierte Dateien enthalten dürfen:

Adapters: Hier können lediglich Ordner und Adapter-
Dateien vom Typ .fa und .tra angelegt werden
Processes: Hier können technische Prozesse (.wrf) zur 
Verknüpfung mit den Aktivitäten abgelegt werden
Resources: Hier können Ressourcen wie Bilder, Text- und 
XML-Dokumente sowie weitere Dateien abgelegt werden
TemproraryFiles: Hier können temporäre Dateien wie 
Text- und XML-Dokumente abgelegt werden
Transformations: Hier können Transformationen (.xsl) 
sowie Reports (.rep) abgelegt werden

Resources Hier können neben Ordnern auch Ressourcen wie Bilder, Text- und 
XML-Dokumente sowie weitere Dateien abgelegt werden.

2.2 BPM-Projekt anlegen

Die automatisch angelegten Ordner und Unterordner können nicht gelöscht, verschoben oder 
umbenannt werden.



•
•
•

BPM-Projekte lassen sich auf verschiedene Arten anlegen:

Über New BPM Project auf der Welcome-Seite des X4 Designers
Über das Kontextmenü New > BPM Project im Repository Navigator
Über das Menü File > New > BPM Project


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4.

Im X4 Designer Menü File > New> BPM Project wählen.

Leere Projektvorlage oder eine vorhandene Projektvorlage wählen.
In Project name den Namen des Projekts eingeben.
Finish klicken, um das Projekt anzulegen.
Ein leeres BPM-Projekt mit der vordefinierten Struktur wird im Repository Navigator angelegt.

2.3 Prozesslandkarten modellieren
Mit einer Prozesslandkarte (Process Landscape) können Sie Prozesslandschaften im X4 Designer
übersichtlich darstellen und beliebige Prozesse und andere Dokumente verknüpfen.
Alle relevanten Prozesse können Sie hier grafisch darstellen und der logische Zusammenhangs von 
Prozessen lässt sich kompakt dokumentieren. Eine so erstellte Prozesslandkarte bietet somit eine 
übergeordnete Sicht auf Führungs-, Wertschöpfungs- und Unterstützungsprozesse und bilden die 
Grundlage für das Qualitätsmanagement.

Prozesslandkarten werden auf oberster Ebene eines BPM-Projektes angelegt. Jedes BPM-Projekt 
darf nur eine Prozesslandkarte erhalten, welche den Projektnamen als Namen trägt, z. B. 
Demoprojekt.pld. Prozesslandkarten sind nicht ausführbar, sondern dienen lediglich der Übersicht 
über Geschäftsprozesse, die sich in Block Arrow-Elementen verknüpfen lassen. Zudem können Sie 
über Data Objects beliebige weitere Repository-Dateien verknüpfen.

Über das Kontextmenü können nun die verschiedenen Elemente eines BPM-Projektes 
angelegt werden. Die verfügbaren Optionen ändern sich je nachdem an welcher Stelle 
in der Baumstruktur das Kontextmenü aufgerufen wird.


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2.4 Geschäftsprozess erstellen
Mit dem BPMN Editor können Sie fachliche Geschäftsprozessdiagramme gemäß BPMN 2.0
modellieren. 
Sie können sowohl leere Aktivitäten aus der Palette als auch Dateien aus dem Repository auf die 
Zeichnungsfläche ziehen und in der Properties-Sicht deren jeweiligen Eigenschaften konfigurieren, 
um einen ausführbaren Prozess zu erstellen.

Im Free-flow-Modus besteht zudem die Möglichkeit, den BPMN Editor als reines BPMN-
Zeichenwerkzeug mit einer erweiterte BPMN-Palette zu verwenden, wobei die Run/Debug-
Funktion deaktiviert ist.


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6.
7.

8.

9.
•

Innerhalb des Ordners Processes z.B. über das Kontextmenü New > BPM Process einen neuen 
Geschäftsprozess anlegen.

Leere Projektvorlage oder eine vorhandene Projektvorlage wählen.
In File name den Namen des Geschäftsprozesses eingeben.

 Leerzeichen und Umlaute sind hierbei nicht erlaubt! 
Next klicken, um weitere Prozessinformationen einzugeben.

In Process title einen Prozesstitel eingeben.
Der Prozessestitel wird im Prozessdiagramm angezeigt und kann in der Properties-Sicht über 
die Eigenschaft Title verändert und bei Bedarf über Eigenschaft Show Title ein- und 
ausgeblendet werden. 
Unter Process description ggf. eine Prozessbeschreibung hinterlegen.
Unter Free-flow mode ggf. den Free-flow-Modus für Geschäftsrozesse aktivieren und den BPM 
Designer als reines BPMN-Zeichen-Werkzeug mit einer erweiterte BPM-Palette verwenden.

 Im Free-flow-Modus ist die Run/Debug-Funktion deaktiviert.
Finish klicken, um den Geschäftsprozess anzulegen.
Ein leeres BPM-Prozessdiagramm wird unter der Dateinamensendung .bpm im Repository 
gespeichert und im BPMN Designer geöffnet. 
BPM-Prozess wie gewünscht modellieren:

Sequence Flow-Verbindungslinien erstellen:
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Mit dem Mauszeiger über das Start-Symbol fahren, um einen kleinen Pfeil 
anzuzeigen.
Pfeil anklicken und zum End-Symbol ziehen, um einen Sequence 
Flow herzustellen.

Symbole aus der Palette oder dem Repository Navigator per Drag&Drop auf die 
Verbindungslinie ziehen.

Pools und Swimlanes einfügen, siehe Pool/Lane
Event-Elemente einfügen, siehe Events.
Parallel Gateway-Elemente oder Exclusive Gateway-Elemente einfügen, 
siehe Gateways.

2.5 Geschäftsprozesse im BPMN- oder XML-Format importieren
Mit dem BPMN 2.0 Import Wizard lassen sich Prozessdiagramme aus anderen 
Modellierungswerkzeugen, die im Format .xml oder .bpmn vorliegen, als neue BPM-Prozesse ins X4
Repository importieren.

Tipp
Über das Menü Project > Validate Project lässt sich der Prozess über einen 
integrierten Prozess-Validator auf Gültigkeit prüfen.
Wenn Sie Dateien aus dem Repository in Ihren Prozess einbinden und diese in 
der Properties-Sicht entsprechend konfigurieren, können Sie den modellierten 
Prozess über  ausführen. Ausgenommen sind Prozesse im Free-flow-Modus.





X4 BPM 61

1.

2.
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Über das Menü Project > Import BPMN 2.0 Process den BPMN 2.0 Import Wizard öffnen.

Browse klicken, um die gewünschte Datei zu wählen.

Die Datei auswählen und mit Öffnen bestätigen.
Die Datei wird nun im Wizard ausgewählt.
Finish klicken, um die Datei zu importieren.
Die Datei wurde nun importiert und wird als Geschäftsprozess im Repository Navigator 
angezeigt.

2.6 Eigenschaften von Geschäftsprozessen (.bpm)
Geschäftsprozesse (.bpm) werden über den BPMN Editor grafisch modelliert und können auf dem X4 
BPM Server ausgeführt werden, wenn sämtliche Bausteine entsprechend parametriert und korrekt 
mit Repository-Dateien verknüpft wurden.

Sie können anhand der Endung .xml (Standard) oder .bpmn nach der Datei filtern.
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Eigenschaften

Case Management
Case Zeigt an, ob bereits Vorgänge, Vorgangsstatus oder Human Tasks definiert 

wurden

Case States Vorgangsstatus-Werte verwalten, z. B. hinzufügen, löschen oder bearbeiten; 
Dazu die Eigenschaft markieren und auf klicken, siehe Vorgangs-Statuswerte 
verwalten

Business Data Fachdaten zum Vorgang verwalten, z. B. hinzufügen, löschen oder bearbeiten; 
Dazu die Eigenschaft markieren und auf klicken, siehe Vorgangs-Fachdaten 
verwalten

Documentation
Title Freitextfeld für den Prozesstitel

Show Title Prozesstitel durch Aktivieren bzw. Deaktivieren des Auswahlfeldes ein- und 
ausblenden

Description Prozessbeschreibung; Kann bei Bedarf geändert werden
Version Projektversion

 Wenn keine Version gesetzt ist, wird der Zeitstempel als Version genommen.

Project Name Projektname; Kann bei Bedarf geändert werden
Created Erstelldatum des Prozesses
Created by Name des Prozess-Erstellers
Last Update Datum der letzten Änderung  
Last Update by Name des letzten Bearbeiters 
Metadata
Manage Metadata Metadaten verwalten, z. B. hinzufügen, löschen oder bearbeiten; Dazu die 

Eigenschaft markieren und auf klicken, siehe Prozess-Metadaten hinzufügen

Technical
Schema 
Declaration

Schema für Input und Output des Prozesses

•

•

Die Eigenschaften jedes Geschäftsprozesses lassen sich in der Properties-Sicht des BPMN 
Editors bearbeiten, wenn im BPMN Editor ein freier Bereich der Zeichnungsfläche angeklickt 
wird.
Standardmäßig werden die gebräuchlichsten Eigenschaften angezeigt, über die Symbolleiste 
der Properties-Sicht lassen sich jedoch zusätzliche Einstellungen vornehmen:

 Show Categories: Eigenschaften nach Kategorien geordnet anzeigen

 Show Advanced Properties: Erweiterte Eigenschaften anzeigen


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Location Vollständiger relativer Pfad des Prozesses innerhalb des X4 Repositorys; Wird 
automatisch gesetzt.

Can Stop Geschäftsprozess darf während der Ausführung angehalten werden

 Diese Eigenschaft wird nicht an Subprozesse vererbt.

Mögliche Werte:

True: für normale Prozesse (Standard)

False: für kritische Prozesse, die zu Ende laufen müssen

Stop on error Im Fehlerfall die Prozess-Ausführung anhalten

Mögliche Werte:

True: Geschäftsprozess-Ausführung abbrechen, wenn ein Fehler auftritt 
(Standard)

False: Fehlerhaften Prozess weiter ausführen (sofern möglich)

In service Prozess aktiv oder inaktiv setzen. Werden inaktive Prozesse direkt ausgeführt, 
so erhalten sie die Prozess-ID -1 . Subprozesse, also Prozesse, die in anderen 
Prozessen aufgerufen werden, können unabhängig von dieser Eigenschaft 
immer ausgeführt werden.

Mögliche Werte:

True: Prozess kann ausgeführt werden (Standard)

False: Prozess kann nicht ausgeführt werden (nur als Subprozess)

Schedule Schedule-Werkzeug, das zeitgesteuertes Ausführen von Prozessen auf dem X4 
Server ohne X4 Designer ermöglicht; Um einen Zeitplan einzurichten, die 
Eigenschaft markieren und auf  klicken.

Mögliche Werte:

Disabled: Kein Zeitplan wurde festgelegt (Standard)

Enabled: Ein Zeitplan für die Ausführung des Prozesses wurde hinterlegt
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Instance limit Maximale Anzahl von Instanzen dieses Prozesses, die parallel ausgeführt werden 
dürfen

Mögliche Werte:

Beliebige positive ganze Zahl

0: Keine Begrenzung (Standard)

Owner Freitextfeld zur Benennung eines Prozess-Verantwortlichen

Free-flow mode Zeigt an, ob der Free-flow-Modus aktiviert ist. Dabei wird die erweiterte 
BPMN-Palette freigeschaltet, um den BPMN Editor als reines BPMN-Zeichen-
Werkzeug zu verwenden.

2.7 Geschäftsprozess-Komponenten ausrichten
Bausteine eines Geschäftsprozesses lassen sich über den Kontextmenü-Eintrag Layout auf einfache 
Weise aneinander ausrichten. Damit lässt sich schnell und einfach eine saubere, strukturierte 
Darstellung generieren. 

Dazu die gewünschten Prozesskomponenten auswählen und über Rechtsklick das Kontextmenü 
aufrufen. Anschließend Layout und die gewünschte Option wählen.

Folgende Optionen stehen für das Ausrichten der Prozesskomponenten zur Verfügung

Align Horizontal: Komponenten anhand des Mittelwertes horizontal ausrichten
Align Vertical: Komponenten anhand des Mittelwertes vertikal ausrichten
Distribute Horizontal: Komponenten gleichmäßig horizontal verteilen
Distribute Vertical: Komponenten gleichmäßig vertikal verteilen

 

Beachten Sie!

Instance limit wird ignoriert, wenn der Prozesse als Subprozess 
aufgerufen wird.



•

•

Diese Option kann beim Anlegen des Geschäftsprozesses aktiviert 
werden und nicht nachträglich geändert werden.
Im Free-flow-Modus ist die Run/Debug-Funktion für den aktuellen 
Geschäftsprozesses deaktiviert.


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2.8 Prozess-Metadaten hinzufügen
Bei Bedarf können Sie beliebig viele weitere Metadaten zur Prozessdefinition eines technischen 
Prozesses oder Geschäftsprozesses hinzufügen und bearbeiten, z.B. für Dokumentationszwecke.

Im Prozess Editor auf einen leeren Bereich der Zeichnungsfläche klicken, um in der Properties-
Sicht die Prozesseigenschaften anzuzeigen.
Die Eigenschaft Metadata > Manage Metadata wählen und auf   klicken.
Ein Dialog wird geöffnet, in dem Sie beliebige Schlüssel/Wert-Paare definieren können.

Metadaten-Eigenschaften eingeben:
In Name den Name des Metadatums eingeben, z.B. Version.
In Value den entsprechenden Wert eingeben, z.B 1.1.

Um die Reihenfolge eines selektierten Metadatums zu ändern, auf Up oder Down klicken.
OK klicken, um die Einstellungen zu speichern.
Das Metadatum wurde nun hinzugefügt und wird in der Properties-Sicht angezeigt. In der 
Prozessdefinitionsdatei werden die Metadaten im XML-Speicherformat abgelegt.

Für die Optionen Align Horizontal und Align Vertical müssen mindestens zwei 
Prozesskomponenten ausgewählt sein, für die Optionen Distribute 
Horizontal und Distribute Vertical mindestens drei Komponenten.



Über Schaltfläche Remove können Sie ein selektiertes Metadatum löschen.
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3 Case Management

3.1 Vorgänge und Workflows realisieren
Menschen lassen sich in Geschäftsprozesse typischerweise über Aufgaben einbinden. Bei der 
Modellierung von Geschäftsprozessen passiert dies über einen Human Tasks Baustein.

Läuft ein BPM-Prozess während der Ausführung auf einen Human Task, wird die Ausführung des 
Prozesses angehalten und die menschlichen Aufgabe generiert. Der Prozess wartet auf die 
notwendige menschliche Interaktion und setzt die Ausführung fort, sobald die menschliche Aufgabe 
zu dem Prozess abgeschlossen ist.

Anhand des folgenden Beispiels soll die typische Umsetzung mit der X4 Suite dargestellt werden.

BPM-Prozess wie gewünscht modellieren.
Im Beispiel wird ein Freigabeprozess dargestellt, bei dem je nach freizugebenden Betrag 
entweder eine automatische Freigabe oder eine Freigabe durch verschiedene 
Prozessbeteiligte erfolgt.

Über die Prozesseigenschaften Case States und Business Data die entsprechenden 
Fachstatus und Fachdaten definieren:



X4 BPM 67

•

•

3.

4.

5.

Zum Definieren des Fachstatus, siehe Vorgangs-Statuswerte verwalten.

Zum Definieren der Fachdaten, siehe Vorgangs-Fachdaten verwalten.

Über eine Aktivität werden die Daten eingelesen. Die Aktivität ist mit einem technischem 
Prozess verknüpft, der die Daten ausliest und den über den Case Management Adapter alle 
Features (Merkmale) ausgibt. 
Über ein Intermediate wird der Status des Vorgangs gesetzt. 
Hierzu stehen in der Eigenschaft Case State des Intermediate Events alle prozessweit 
definierten Vorgangs-Statuswerte zur Auswahl zur Verfügung.
Über ein Rule-Baustein werden die Regeln hinterlegt, um die Aufgabe je nach Höhe des Betrags 
der entsprechende Person zuzuweisen. Im Input wird dabei angegeben, woher die zu prüfenden 
Daten kommen. Über Case Feature werden die zuvor definierten Merkmale (siehe Vorgangs-
Fachdaten verwalten) angegeben. 

Mit dem Rule-Baustein lassen sich auch Variablen, Features, Benutzerdefinierte 
Platzhalter oder Statuswerte (Case State) auswerten. Dazu lassen sich mit Strg + 
Leertaste im Regel-Bereich alle aktuell verfügbaren Variablen (v:Variablenname),  
Features (f:Featurename), Benutzerdefinierten Platzhalter (p:Platzhaltername) und 
Vorgangs-Statuswerte (c:CaseState) in einer Auswahlliste aufrufen.


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Mit einem Condition-Baustein werden die verschiedenen Ausführungszweige abgebildet. Im 
Condition Editor können die Vorgangszustände des aktuellen Geschäftsprozesses als 
Auswertungskriterium für die Bedingungen verwendet werden, siehe Bedingungen erstellen 
und verwenden.

Für jeden Ausführungszweig den entsprechenden Human Task und damit die Funktionen 
der Task Management Web App konfigurieren.
Prozess speichern und ausführen.
Die Task Management Web App über das Menü Tools > X4 Task Management öffnen.
In der Task Management Web App einloggen. 
Die zu bearbeitenden Vorgänge werden nun angezeigt.

Welcher Benutzer einen Vorgang bearbeiten darf, über den Rule-Baustein ausgewertet.
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Vorgänge wie gewünscht bearbeiten.

3.2 Vorgangs-Fachdaten verwalten
Um Vorgänge mit X4 BPM abzubilden, ist es erforderlich, die benötigten Struktur der Fachdaten für 
den Geschäftsprozess zu definieren. In der Prozesseigenschaft Business Data können Sie eine 
dreistufige Hierarchie mit Fachdatenstrukturen inklusive der zugehörigen Beschreibung definieren 
und somit der Prozessdefinition hinzufügen.

3.2.1 Aufbau von Vorgangs-Fachdaten
Fachdaten eines Vorgangs werden in Kategorien, Gruppen und Merkmale untergliedert: 

Kategorien gruppieren Fachdaten auf höchster Ebene und enthalten Gruppen. Jede Kategorie 
besitzt einen Namen, eine Position und eine optionale Beschreibung.
Gruppen fassen Merkmale von Fachdaten innerhalb einer Kategorie zusammen. Jede Gruppe 
besitzt einen Namen, eine Position und eine optionale Beschreibung.
Merkmale sind die konkreten Eigenschaften der Vorgangs-Fachdaten, z.B. ein Auftragsdatum 
innerhalb einer Merkmals-Gruppe. Jedes Merkmal besitzt einen Namen, eine Position, eine 
optionale Beschreibung, einen Datentyp sowie einen optionalen Standardwert.

Verfügbare Datentypen für Merkmale sind:

String: Zeichenkette
Integer: Ganzzahl 
Decimal: Fließkommazahl
Boolean: Boolescher Wert
DateTime: Datum und Uhrzeit

3.2.2 Vorgangs-Fachdaten hinzufügen

Im BPMN Editor auf einen leeren Bereich der Zeichnungsfläche klicken, um in der 
Properties-Ansicht die Prozesseigenschaften anzuzeigen.
In der Properties-Sicht unter Case Management die Eigenschaft Business Data wählen und 
auf   klicken.
Ein Dialog wird geöffnet, in dem Sie die Struktur der Fachdaten und deren Beschreibung 

Welche Bearbeitungsfunktionen verfügbar sind, hängt von der Konfiguration im Human 
Task ab.


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definieren können.

Auf Add klicken oder über   Add > Category wählen, um eine neue Merkmalskategorie 
(Category) zu definieren:

In Name den Name der Kategorie eingeben, z.B. Electronic Invoice.
In Description eine zugehörige Beschreibung eingeben (optional).

Um eine Merkmals-Gruppe zu definieren, innerhalb einer Kategorie auf Add klicken oder über 

 Add > Group wählen.
In Name den Name der Gruppe eingeben, z.B. Invoice Data.
In Description eine zugehörige Beschreibung eingeben (optional).

Um ein Merkmal zu definieren, innerhalb einer Merkmals-Gruppe auf Add klicken oder über 
 Add > Feature wählen.

In Name den Name der Gruppe eingeben, z.B. Invoice Number.
In Description eine zugehörige Beschreibung eingeben (optional).
In Type den Datentyp (siehe oben) für das Merkmal wählen, z.B. Integer.
In Default Value falls möglich einen Standardwert eingeben, z.B. 1.

Um die Reihenfolge eines selektierten Elements zu ändern, auf   oder   klicken.
OK klicken, um die Definition der Vorgangs-Fachdaten zu speichern.
Die Vorgangs-Fachdaten-Definitionen werden in der Properties-Sicht angezeigt.

Über Schaltfläche Delete können Sie einen in der Baumstruktur selektierten Eintrag löschen.
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3.3 Vorgangs-Statuswerte verwalten
Um Vorgänge mit X4 BPM abzubilden, ist es erforderlich, die benötigten Statuswerte des 
Geschäftsprozesses zu definieren. In der Prozesseigenschaft Case States können Sie beliebige 
Statuswerte und Statusbeschreibungen definieren und somit der Prozessdefinition hinzufügen.

3.3.1 Vorgangs-Statuswerte hinzufügen

Im BPMN Editor auf einen leeren Bereich der Zeichnungsfläche klicken, um in der 
Properties-Ansicht die Prozesseigenschaften anzuzeigen.
In der Properties-Sicht unter Case Management die Eigenschaft Case States wählen und auf 

 klicken.
Ein Dialog wird geöffnet, in dem Sie Statuswerte und deren Beschreibung definieren können.

Auf Add klicken, um einen neuen Status zu definieren:
In Name den Name des Status eingeben, z.B. Approved.
In Description eine zugehörige Beschreibung eingeben (optional).

Um die Reihenfolge eines selektierten Statuswerts zu ändern, auf   oder   klicken.
OK klicken, um die Vorgangsstatus-Definition zu speichern.
Die Vorgangsstatus-Definitionen werden in der Properties-Sicht angezeigt. 

Über Schaltfläche Delete können Sie einen selektierten Statuswert löschen.
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3.4 Task Management Web App
Über Human Tasks lassen sich Menschen in Geschäftsprozesse einbinden. Die Task Management Web 
App bietet die entsprechende Oberfläche zur Abarbeitung der definierten Aufgaben. 

Die Task Management Web App besitzt bereits eine vordefinierte Struktur und vordefinierte 
Funktionen. Innerhalb des entsprechenden BPM-Prozesses und über verschiedene Einstellungen im 
Human Task Editor lassen sich jedoch weitere Einstellungen vornehmen.  

3.4.1 Fachdaten definieren und anzeigen
Fachdaten werden über die BPM-Prozesseigenschaft Business Data definiert, siehe Vorgangs-
Fachdaten verwalten. Welche der definierten Fachdaten für den Benutzer in der Task Management 
Web App tatsächlich angezeigt werden, wird über den Human Task Editor, innerhalb der 
Registerkarte Business Data angegeben.

Vorgangs-Status mit Intermediate Events setzen
Den Status eines Vorgangs, der zur Laufzeit des aktuellen Geschäftsprozesses bearbeitet 
werden soll, können Sie auch mit Intermediate Events setzen. Hierzu stehen in 
Eigenschaft Case Management > Case State des Intermediate Events alle prozessweit 
definierten Vorgangs-Statuswerte zur Auswahl zur Verfügung. 



Die Task Management Web App lässt sich über das Menü Tools > X4 Task 
Management öffnen. Die Standard-Zugangsdaten sind admin/demo.


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3.4.2 Status definieren und setzen
Statuswerte werden über die BPM-Prozesseigenschaft Case States definiert, siehe Vorgangs-
Statuswerte verwalten. Welche der definierten Status ein Benutzer in der Task Management Web 
App für seine Vorgänge tatsächlich setzen kann, wird über den Human Task Editor, innerhalb der 
Registerkarte Actions angegeben. 
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3.4.3 Vorgänge ablehnen und weiterleiten
Ob der Bearbeiter die Möglichkeit haben soll, Vorgänge abzulehnen oder weiterzuleiten, kann im 
Human Task Editor, innerhalb der Registerkarte Settings definiert werden.
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3.4.4 Dokumente anzeigen und bearbeiten
Ob Dokumente in der Task Management Web App angezeigt und ggf. bearbeitet werden sollen, wird 
im Human Task Editor, innerhalb der Registerkarte Settings definiert.

Mit Enable Documents werden die Registerkarte Dokumente sowie die Schaltfläche 
Herunterladen in der Task Management Web App eingeblendet.  
Über Documents can be added/edited können Dokumente bearbeitet (Schaltfläche 
Hochladen) und hinzugefügt (Schaltfläche Neues Dokument) werden.  
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3.4.5 Fälligkeitsmanagement für Vorgängen
Für jeden Vorgang kann eine Fälligkeit definiert werden. Diese wird innerhalb des Human Task 
Editors unter General > Deadline angegeben. Neben einer Frist (Duration) kann auch eine genaue 
Fälligkeit (Until) mit Datum und Uhrzeit definiert werden. Zudem kann über Case State ein Status 
angegeben werden, der automatisch ausgeführt wird, wenn die Frist des Vorgangs erreicht wurde.
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Ist die Fälligkeit des Vorgangs eingetreten, bevor er bearbeitet werden konnte und der Prozess wurde 
automatisch mit einem konfigurierten Case State fortgesetzt, wird der Vorgang automatisch 
geschlossen und innerhalb der Task Management Web App in den Ordner Verfallen verschoben. Hier 
werden alle Vorgänge angezeigt, die die Frist überschritten haben und automatisch geschlossen 
wurden.
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Um Vorgänge mit einer Deadline besser hervorzuheben, werden diese in der Task Management Web 
App farblich gekennzeichnet:

: Die Fälligkeit des Vorgangs wurde überschritten und der Vorgang wurde automatisch 
geschlossen und in den Ordner Verfallen verschoben.

: Der Vorgang ist noch am selben Tag fällig.
: Die Fälligkeitsdauer zur Abarbeitung des Vorgangs ist > 24 Stunden. 
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